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Preface

Welcome to the JD Edwards EnterpriseOne Tools HTML Server on WebSphere Reference Guide for Microsoft Windows.


Audience

This guide is intended for system administrators and technical consultants who are responsible for installing and configuring IBM WebSphere and JD Edwards EnterpriseOne.





Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.





Related Documents

You can access related documents from the JD Edwards EnterpriseOne Release Documentation Overview pages on My Oracle Support. Access the main documentation overview page by searching for the document ID, which is 876932.1, or by using this link:

https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1

To navigate to this page from the My Oracle Support home page, click the Knowledge tab, and then click the Tools and Training menu, JD Edwards EnterpriseOne, Welcome Center, Release Information Overview.

This guide contains references to server configuration settings that JD Edwards EnterpriseOne stores in configuration files (such as jde.ini, jas.ini, jdbj.ini, jdelog.properties, and so on). Beginning with the JD Edwards EnterpriseOne Tools Release 8.97, it is highly recommended that you only access and manage these settings for the supported server types using the Server Manager program. See the JD Edwards EnterpriseOne Server Manager Guide.





Conventions

The following text conventions are used in this document:


	Convention	Meaning
	Bold	Indicates field values.
	Italics	Indicates emphasis and JD Edwards EnterpriseOne or other book-length publication titles.
	Monospace	Indicates a JD Edwards EnterpriseOne program, other code example, or URL.












1 Accessing Certifications (formerly Minimum Technical Requirements)

Customers must conform to the supported platforms for the release as detailed in the Certifications for JD Edwards EnterpriseOne. In addition, JD Edwards EnterpriseOne may integrate, interface, or work in conjunction with other Oracle products. Refer to the following link for cross-reference material in the Program Documentation for Program prerequisites and version cross-reference documents to assure compatibility of various Oracle products.

http://www.oracle.com/corporate/contracts/index.html

Access the Certifications from My Oracle Support (https://support.oracle.com) by searching for this product from the Certifications tab:

	
JD Edwards EnterpriseOne HTML Server









2 Understanding Server Manager and This Guide

Beginning with JD Edwards EnterpriseOne Tools Release 8.97, a new tool called Server Manager is provided. This tool is a complete replacement for the JD Edwards EnterpriseOne legacy management and installation tools including internal components known as Server Administration Workbench (SAW), Server Management Console (SMC), and the InstallShield based installers previously used to install or upgrade JD Edwards EnterpriseOne servers. As a result, you should refer to the JD Edwards EnterpriseOne Server Manager Guide for details on installing and configuring all JD Edwards EnterpriseOne server products, with the exception of the JD Edwards EnterpriseOne Deployment Server, whose installation is described in this guide. This guide only contains reference information for functionality outside the Server Manager tool.




	
Note:

Management of JD Edwards EnterpriseOne Tools Release 8.96 or earlier must be done using the existing tools. Server Manager cannot be used to manage any JD Edwards EnterpriseOne Tools Release prior to 8.97.







The Server Manager tool provides:

	
Web Based System Management

You can securely access and manage your JD Edwards EnterpriseOne installation from anywhere using a standard web browser.


	
Remote Deployment and Upgrades

You can install, uninstall, and update your JD Edwards EnterpriseOne servers regardless of their physical location or platform.


	
Remote Operational Control

You can start and stop any of your JD Edwards EnterpriseOne servers, Oracle J2EE application servers, or supported third party J2EE application servers directly from the Management Console.


	
Secure Administrative Tasks

Server Manager permits you to specify which existing JD Edwards EnterpriseOne users have access to the Management Console control which JD Edwards EnterpriseOne servers the user may view, and specify which administrative tasks the user may perform on those servers.


	
Configuration Management

Server Manager provides a web-based interface for managing the configuration of all managed servers. The application presents each configuration item along with integrated help describing the configuration setting.




	
Note:

Beginning with the availability of Server Manager, it is strongly advised that all changes to configuration files (such as jde.ini, jas.ini, jdbj.ini, jdelog.properties, etc.) for any JD Edwards EnterpriseOne server managed by Server Manager be accomplished using only the Management Console interface of Server Manager. In addition to providing usability improvements, using Server Manager reduces the risk of introducing configuration errors by providing dropdowns that contain only valid values where applicable. Further, the tool provides a useful audit history for any modifications made to configurations using Server Manager.








	
Configuration Comparison

Use Server Manager to compare the configuration of two or more servers to identify configuration differences. You can compare configurations through the Management Console application regardless of the platform or location of the actual JD Edwards EnterpriseOne server. You can also compare individual servers with the default configuration of the corresponding server groups to which the servers belong.


	
Audit History

Server Manager maintains a history of changes made to the managed servers. This includes a history of each configuration change, each server start and stop, and each tools release update, including the user that performed the change or operation. The Management Console application provides mechanisms to query and view the audit history that is maintained.


	
Integrated EnterpriseOne Software Management

Use Server Manager to centrally maintain all your JD Edwards EnterpriseOne server tools releases, including the ability to copy the software to the remote server machines.


	
Logical Server Grouping

Server Manager allows you to group servers with a similar purpose. These groups can include any of the server types such as Enterprise Server, HTML Server, and so on. A default, or template, configuration is maintained for each server group.


	
Application Release Independence

Server Manager is delivered with JD Edwards EnterpriseOne Tools Release 8.97 and is compatible with any supported JD Edwards EnterpriseOne application release beginning with Application Release 8.9 through the currently supported release. No electronic software updates (ESUs) are required to support Server Manager.


	
Self-Contained Installation

The installation of Server Manager delivers all components that are required by the Management Console application. There are no third party requirements regardless of your existing or intended middleware topology (for example, WebLogic Server, Oracle Application Server, WebSphere Application Server, or no application server).


	
Tools Release Independence

Newer versions of the Server Manager application will continue to support the management of earlier tools releases back to JD Edwards EnterpriseOne Tools Release 8.97.









3 Installing, Updating, and Configuring WebSphere 8.5 and 8.5.5




	
Note:

Unless otherwise noted, all references to WebSphere version 8.5 are also applicable to WebSphere version 8.5.5.







Beginning with JD Edwards EnterpriseOne Tools Release 9.1 Update 2.3, the IBM WebSphere Application Server Release 8.5 is supported.

Beginning with JD Edwards EnterpriseOne Tools Release 9.1 Update 3.3, the IBM WebSphere Application Server Release 8.5.5 is supported. This fix pack can be installed as a new installation or an update.

Relative to WebSphere 7.0, with IBM WebSphere 8.5 the installation procedure has changed dramatically. You will now use the IBM Installation Manager as a central hub to manage the installation process. The IBM Installation Manager is designed to make the installation procedure much simpler and easier than in prior releases.

Additionally IBM WebSphere Application Server 8.5 supports SDK 1.6 as the basic configuration but with SDK 1.7 as an optional configuration. For JD Edwards EnterpriseOne, the implementation requires SDK 1.7 as the default run-time configuration for WebSphere Application Server 8.5. Therefore, after WebSphere Application Server is installed with the basic configuration, you MUST change the default SDK to 1.7.

This chapter describes these tasks:

	
Section 3.1, "Before You Begin"


	
Section 3.2, "Installing the IBM Installation Manager"


	
Section 3.3, "Installing an IBM WebSphere Application Server 8.5 or 8.5.5"


	
Section 3.4, "Creating a New Profile for WebSphere Application Server 8.5"


	
Section 3.5, "Installing the IBM HTTP Server 8.5"


	
Section 3.6, "Installing Web Server Plug-ins for IBM WebSphere Application Server"


	
Section 3.7, "Enabling SDK 7.0 on WebSphere Application Server 8.5"


	
Section 3.8, "Switching to SDK 7.0 on WebSphere Application Server 8.5"


	
Section 3.9, "Installing the WebSphere Customization Toolbox"


	
Section 3.10, "Installing or Updating to WebSphere 8.5 Fix Pack"


	
Section 3.11, "Configuring the IBM Web Server Plug-in"


	
Section 3.12, "Setting the HTTP Server Properties"


	
Section 3.13, "Manually Generating a Plug-in"


	
Section 3.14, "Manually Editing the HTTP Configuration File"






3.1 Before You Begin

Before you install WebSphere, you must first set up a local user account that is in the Administrative group and has these advanced user rights:

	
Act as part of operating system


	
Create a token object


	
Log on as a service


	
Replace a process level token




To set up a local user account with the above user rights, navigate to:

Control Panel > Administrative Tools > Local Security Policy > Local Policies > Users Rights Assignment

On User Rights Assignment, double-click one of the user rights, click Add, select a local user account from the list, and click OK. Repeat this process for the remaining user rights.

You should also download all the required software from the JD Edwards Update Center.






3.2 Installing the IBM Installation Manager

For all supported platforms, you must install the IBM Installation Manager before an IBM WebSphere Application Server can be installed. Follow the steps below to install the Installation Manager.

	
After you have downloaded and unzipped the IBM Installation Manager software, locate the install executable.

On Microsoft Windows 2008R2, you must right-click and select the Run as administrator option.

[image: This image is described in surrounding text]

	
On Install Packages, package selection, select the check box for the latest version of the IBM Installation Manager.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, review the International Program License Agreement and click the radio button to accept the terms if you want to continue with the installation.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, select a location for Installation Manager, enter an installation directory.

For example:

Z:\IBM\Installation Manager\eclipse

[image: This image is described in surrounding text]

	
On Install Packages, summary information, review the summary information and click the Install button to begin the installation.

[image: This image is described in surrounding text]

	
On Install Packages, if you are ready to install using the IBM Installation Manager, click the Restart Installation Manager button.


	
After the Installation Manager is restarted, continue to the next section in this chapter entitled: Section 3.3, "Installing an IBM WebSphere Application Server 8.5 or 8.5.5".









3.3 Installing an IBM WebSphere Application Server 8.5 or 8.5.5

IBM WebSphere Application Server (WAS) 8.5 is installed through the IBM Installation Manager. Fix Pack 8.5.5 can be installed as a new installation or an update. For purposes of this procedure, all references are to release 8.5, but you can substitute 8.5.5 where applicable.

To install an IBM WebSphere Application Server 8.5:

	
Start the IBM Installation Manager, which you must have previously installed as described in the preceding chapter of this guide entitled: Section 3.2, "Installing the IBM Installation Manager".

The IBM Installation Manager screen displays.

[image: Surrounding text describes install_man_start.gif.]

	
You must configure the software repository in the Installation Manager before you can start the product installation. On the initial screen of the IBM Installation Manager, navigate File > Preferences.

[image: This image is described in surrounding text]

[image: This image is described in surrounding text]

	
On Preferences, click on the Add Repository... button and enter the location of the repository.config for each of the product. For example:

Z:\Software\WAS85\ND\repository.config

Z:\Software\WAS85\Suppl\repository.config

Z:\Software\WAS85\JDK17\repository.config

[image: This image is described in surrounding text]

	
Optionally, if needed for your installation, you should enable a proxy server and enter proxy information.


	
After all repositories are added, click the Install option from the Installation Manager.

IBM Installation Manager displays a list of available products, as shown in the following example:

[image: This image is described in surrounding text]

	
The IBM Install Manager displays a list of available products (packages) to install.

[image: This image is described in surrounding text]

	
On Install Packages, select packages, select the products you want to install such as:

	
WebSphere Network Deployment


	
SDK 1.7





	
Click the Next button.




	
Note:

Once the installation begins, the installer may prompt to inform you that updates are available.







If Updates are available, the installer will display a list as shown in this example:

[image: This image is described in surrounding text]

	
If the IBM Install Manager displays a list of updates, it is recommended that you click the Select Recommended button to accept and install the updates.


	
On Install Packages, review the International Program License Agreement and click the radio button to accept the terms if you want to continue with the installation.

[image: This image is described in surrounding text]

	
On Install Packages, select location for the shared resources directory, enter an appropriate location for IMShared. These files will be used by all IBM products installed through the Installation Manager (such as HTTP Server and Customization Toolbox).

For example:

z:\IBM\IMShared


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, package group, click the radio button entitled: Create a new package group.

In the Installation Directory field, enter an appropriate location to install the IBM WebSphere Application Server 8.5 software. It does not have to be the same location as the shared location.

For example:

z:\IBM\WebSphere\AppServer


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, translations, select your desired language.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, select features, verify that the package for Java JDK 1.7 is selected.




	
Caution:

Although JDK 1.6 is the default installation, you must choose to install JDK 1.7 in order to be compatible with JD Edwards EnterpriseOne.








	
Click the Next button.


	
Click the Install button.

[image: This image is described in surrounding text]

	
On Install Packages, the packages are installed, click the Finish button.


	
To create a profile, ensure this radio button in the right pane is selected:

Profile Management Tool to create a profile.

Continue to the next section of this chapter entitled: Section 3.4, "Creating a New Profile for WebSphere Application Server 8.5".









3.4 Creating a New Profile for WebSphere Application Server 8.5

The section describes how to create a new profile. This profile will be used later in the installation process to create a web server and configure the plugin.

Note: This document describes how to create a "standalone" application server. For information on how to create a cell and managed node, refer to IBM's Infocenter:

http://www-01.ibm.com/software/webservers/appserv/was/library/

You can choose to create your first profile now or after the remaining software packages have been installed. If you create your profile now, you will need to manually define the web server before configuring the plug-in later in this chapter. As an alternative, you can use the advanced profile creation option to automatically create a web server, but this must be done after all of the other software components described in this guide are installed and updated to the correct level.

This procedure assumes you are creating a new profile at this time so that you can verify your installation.

	
If you followed the last step in the preceding chapter entitled: Section 3.3, "Installing an IBM WebSphere Application Server 8.5 or 8.5.5", the Profile Management Tool was launched.

Alternately, you can use this navigation:

IBM WebSphere > IBM WebSphere Application Server > Tools > Profile Management Tool

[image: This image is described in surrounding text]

	
On WebSphere Customization Toobox, Profile Management Tool, with the Profiles tab selected, click the Create button.

[image: This image is described in surrounding text]

	
On Profile Management Tools, Environment Selection, highlight the Application server environment type.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Profile Creation Options, select the Typical profile creation radio button.




	
Note:

Choosing Typical profile creation uses the default configuration settings. It assigns unique names to the profile, node, and host. The tool also assigns unique port values.
Alternatively, you can choose Advanced profile creation to specify your own values for settings such as the location of the profile and names of the profile, node, and host.










	
Click the Next button.

[image: This image is described in surrounding text]

	
On Administrative Security, clear the Enable administrative security checkbox.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Profile Creation Summary, review the information for accuracy and click the Create button.

[image: This image is described in surrounding text]

The progress screen is displayed. Wait for the progress to complete 100%, which may take several minutes.

[image: This image is described in surrounding text]

	
Optionally, on Profile Creation Complete, you can select the check box for Launch the First steps console.


	
Click the Finish button.

[image: This image is described in surrounding text]

	
If you chose to run First Steps, on WebSphere Application Server, First steps, select the first option, which is entitled: Installation verification.

[image: This image is described in surrounding text]

	
Verify that the installation verification completed successfully. You should get the message entitled: The installation verification is complete.


	
Close the screen for the First steps output.


	
Verify that you can sign on to the Administration Console. For example:

http://host:9060/ibm/console









3.5 Installing the IBM HTTP Server 8.5

The IBM HTTP Server 8.5 must be installed through the IBM Installation Manager.

In order to install the IBM HTTP server, you must have the Supplemental images in the repository, as shown in the second line item in the following screen sample.

[image: This image is described in surrounding text]

To install an IBM HTTP Server 8.5:

[image: This image is described in surrounding text]

	
Start the IBM Installation Manager, which you must have previously installed as described in the preceding chapter of this guide entitled: Section 3.2, "Installing the IBM Installation Manager".


	
Click the Install option.

[image: This image is described in surrounding text]

	
On Install Packages, select packages, click the checkboxes for the HTTP Server for WebSphere Application Server and the HTTP Server Version (8.5.x).


	
Click the Next button.


	
Review the International Program License Agreement and click the radio button to accept the terms if you want to continue with the installation.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, package group, click the radio button entitled: Create a new package group. In the Installation Directory field, enter an appropriate location to install the IBM HTTP Server 8.5 software. It does not have to be the same location as the shared location.

For example:

z:\IBM\HTTPServer

This document refers to a local IBM HTTP server installed on the same machine as the IBM WebSphere Application Server. For instructions on how to install a remote HTTP server, refer to the IBM info center:

http://www-01.ibm.com/software/webservers/appserv/was/library/

Also note that the shared location that you defined when you installed the IBM WebSphere Application Server in the previous section cannot be changed.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, select the features to install, verify the package you chose is selected.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, configuration, complete these fields:

	
HTTP Port

Specify a port for IBM HTTP Server to communicate. The default port is 80. If the default port is already in use, then change to another port that is available. Running IBM HTTP Server without root or Administrative privilege might restrict use of ports below 1024.




	
Run IBM HTTP Server as a Windows Service

Ensure this check box is checked.


	
Log on as a local system account

Normally this check box should be selected. However your network configuration may require you to specify a user with specific authority across domains or network segments. Contact your System Administrator for more information.


	
Startup type

Use the pulldown to choose a startup type for the Windows service. The default value is Automatic.





	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, review summary information, verify the accuracy of the selections.


	
Click the Install button to begin the installation of the IBM HTTP Server.

[image: This image is described in surrounding text]

	
On Install Packages, verify the installation completed successfully. You may want to click the link: View Log File.


	
Click the Finish button.

You are returned to the IBM Installation Manager home screen.


	
To install the plug-ins, continue to the next section entitled: Section 3.6, "Installing Web Server Plug-ins for IBM WebSphere Application Server".









3.6 Installing Web Server Plug-ins for IBM WebSphere Application Server

As with the previous software packages described in this guide, the plug-ins for IBM WebSphere Application Server 8.5 must be installed using the IBM Installation Manager.

In order to install the IBM HTTP server, you must have the Supplemental images in the repository, as shown in the second line item in the following screen sample.

[image: This image is described in surrounding text]

To install Web Server Plug-ins for IBM WebSphere Applications Server:

	
Start the IBM Installation Manager, which you must have previously installed as described in the preceding chapter of this guide entitled: Section 3.2, "Installing the IBM Installation Manager".

[image: This image is described in surrounding text]

	
On IBM Installation Manager, click the Install option.

[image: This image is described in surrounding text]

	
On Install Packages, select packages, click the checkboxes for the Web Server Plug-ins for WebSphere Application Server and the HTTP Server Version (8.5.x).


	
Click the Next button.


	
On Install Packages, review the International Program License Agreement and click the radio button to accept the terms if you want to continue with the installation.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, package group, click the radio button entitled: Create a new package group.

In the Installation Directory field, enter an appropriate location to install the Web Server Plugins for IBM WebSphere Application Server 8.5.

For example:

z:\IBM\WebSphere\Plugins




	
Note:

New functionality for IBM WebSphere 8.5 for the plug-in installs provides this default location:
\IBM\WebSphere\Plugins

The remainder of this guide assumes you chose to accept the default location.










	
On Install Packages, review summary information, verify the accuracy of the selections.


	
Click the Install button to begin the installation of the JDK.

The progress screen is displayed. Wait for the progress to complete 100%, which may take several minutes.

[image: This image is described in surrounding text]

	
On Install Packages, verify the installation completed successfully. You may want to click the link: View Log File.


	
Click the Finish button.

You are returned to the IBM Installation Manager home screen.


	
To install the plug-ins, continue to the next section entitled: Section 3.9, "Installing the WebSphere Customization Toolbox".









3.7 Enabling SDK 7.0 on WebSphere Application Server 8.5

Starting with WebSphere Application Server 8.5, SDK 7.0 is supported as an optional feature. The java 1.6 is still the default installation.




	
Caution:

JD Edwards EnterpriseOne supports WebSphere Application Server 8.5 running with SDK 7.0 only. You must switch the java level after the installation is completed.







You can switch the java level by using the managesdk command. The executable for the managesdk command is located in the bin directory of your profile. For example:

Z:\IBM\WebSphere\AppServer\profiles\AppSrv01\bin

This section discusses how to use the managesdk command for these purposes:

	
View Available Java Products


	
View Available Java Products with Detail Information


	
Syntax Examples using the managesdk Command





View Available Java Products

Use this command to view the available Java products:

managesdk.bat -listAvailable

The following shows a sample of returned information.

[image: Surrounding text describes managesdk_example_1.gif.]


View Available Java Products with Detail Information

Use this command to view the available Java products with detail information:

managesdk.bat -listAvailable -verbose

The following shows sample returned information.

[image: Surrounding text describes managesdk_example_2.gif.]


Syntax Examples using the managesdk Command

The following examples demonstrate correct syntax when you run the managesdk command:


managesdk.bat -listAvailable [-verbose]
 
managesdk.bat -listEnabledProfile -profileName AppSrv01 [-verbose]
 
managesdk.bat -listEnabledProfileAll [-verbose]
 
managesdk.bat -enableProfile -profileName AppSrv01 -sdkname 1.7_64 -enableServers
 
managesdk.bat -enableProfileAll -sdkname 1.7_64 -enableServers
 
managesdk.bat -getNewProfileDefault [-verbose]
 
managesdk.bat -setNewProfileDefault -sdkname 1.7_64
 
managesdk.bat -getCommandDefault [-verbose]
 
managesdk.bat -setCommandDefault -sdkname 1.7_64






3.8 Switching to SDK 7.0 on WebSphere Application Server 8.5




	
Caution:

JD Edwards EnterpriseOne supports WebSphere Application Server 8.5 running with SDK 7.0 only. You must switch the java level after the installation is completed.







This section describes these topics:

	
Section 3.8.1, "Working with the managesdk Command"


	
Section 3.8.2, "Modify the JD Edwards EnterpriseOne Server Manager Agent with JRE 1.7.0"






3.8.1 Working with the managesdk Command

This section discusses how to use the managesdk command for these purposes:

	
View List of Available SDK Names


	
Set the command default to the version 7.0 SDK


	
Set the New Profile Default to the Version 7.0 SDK


	
If Profiles Already Exist, Enable the Profiles to use the Version 7.0 SDK





View List of Available SDK Names

Use this command to view a list of available SDK names for the product installation:

managesdk.bat -listAvailable

The following shows sample returned information.

[image: Surrounding text describes managesdk_example_1.gif.]


Set the command default to the version 7.0 SDK

Use this command to set the command default to the version 7.0 SDK:

managesdk.bat -setCommandDefault -sdkname 1.7_64

The following shows sample returned information.

[image: Surrounding text describes managesdk_example_3.gif.]


Set the New Profile Default to the Version 7.0 SDK

Use this command to set the new profile default to version 7.0 SDK:

managesdk.bat -setNewProfileDefault -sdkname 1.7_64

The following shows sample returned information.

[image: Surrounding text describes managesdk_example_4.gif.]


If Profiles Already Exist, Enable the Profiles to use the Version 7.0 SDK

If profiles already exist, use this command to enable the profiles to use the version 7.0 SDK:

managesdk.bat -enableProfileAll -sdkname 1.7_64 -enableServers

The following shows sample returned information.

[image: Surrounding text describes managesdk_example_5.gif.]




	
Note:

To change federated profiles in a Network Deployment installation, the deployment manager must be running. The managesdk command updates the master configuration repository. After the command runs, a synchronization operation must occur before the new SDK can be used for federated profiles.












3.8.2 Modify the JD Edwards EnterpriseOne Server Manager Agent with JRE 1.7.0

Use this procedure to modify the Server Manager Agent with JRE 1.7.0:

	
Stop the JD Edwards EnterpriseOne Server Manager Agent.


	
Copy the JRE folder from the JDK 1.7 version to this folder:

\jde_home\SCFHA\jdk


	
Start the JD Edwards EnterpriseOne Server Manager Agent.











3.9 Installing the WebSphere Customization Toolbox

New tool functionality with IBM WebSphere 8.5 includes the requirement to install the WebSphere Customization Toolbox. This tool aids in configuring your plug-in properly. The WebSphere Customization Toolbox comes from the supplemental software repository that was downloaded, decompressed, and added to the repository list as described in previous procedures in this document.

	
Start the IBM Installation Manager.

[image: This image is described in surrounding text]

	
On IBM Installation Manager, click the Install option.

[image: This image is described in surrounding text]

	
On Install Packages, select packages, select the two check boxes for WebSphere Customization Toolbox and his package and version Version 8.5.x.


	
Click the Next button.


	
On Install Packages, review the International Program License Agreement and click the radio button to accept the terms if you want to continue with the installation.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, package group, click the radio button entitled: Create a new package group.

In the Installation Directory field, enter an appropriate location to install the WebSphere Customization Toolbox 8.5.

For example:

z:\IBM\WebSphere\Toolbox


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, select features, select Web Server Plug-ins Configuration Tool.


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Install Packages, review summary information, verify the accuracy of the selections.


	
Click the Install button to begin the installation of the WebSphere Customization Toolbox.

[image: This image is described in surrounding text]

The progress screen is displayed. Wait for the progress to complete 100%, which may take several minutes.

[image: This image is described in surrounding text]

	
On Install Packages, verify the installation completed successfully. You may want to click the link: View Log File.


	
Click the Finish button.

You are returned to the IBM Installation Manager home screen.









3.10 Installing or Updating to WebSphere 8.5 Fix Pack

Use these procedures to install or update your existing WebSphere components to WebSphere 8.5.0 Fix Pack:

	
Section 3.10.1, "Updating the IBM Installation Manager to WebSphere 8.5 or Greater"


	
Section 3.10.2, "Updating WebSphere Application Server 8.5 or Greater"


	
Section 3.10.3, "Working with the HTTP Server Component"


	
Section 3.10.4, "Working with the Plug-ins Component"


	
Section 3.10.5, "Working with the Customization Toolbox Component"






3.10.1 Updating the IBM Installation Manager to WebSphere 8.5 or Greater

Use this procedure to update the IBM Installation Manager.




	
Note:

For instructions on installing the Update Installer itself, refer to the section of this guide entitled: Section 4.5, "Installing the WebSphere Update Installer".







	
Start the IBM Installation Manager using the IBMIM executable..


	
Open the Preferences of the IBM Installation Manager.

[image: Surrounding text describes update_installer_pref.gif.]

	
Highlight the Updates node and select this checkbox:

Search for Installation Manager Updates


	
Log out of IBM Installation Manager.


	
Log in to the Installation Manager and you will be prompted if a new version of Installation Manager is available.

[image: Surrounding text describes update_installer_update.gif.]

	
On IBM Installation Manager, click the Yes button and follow the installation wizard to complete the upgrade.









3.10.2 Updating WebSphere Application Server 8.5 or Greater

Use this procedure to update WebSphere 8.5 or greater.

	
Stop all the WebSphere Processes including the HTTP Server and Web Server.


	
Launch the IBM Installation Manager using the IBMIM executable.


	
Select the Update option.

[image: Surrounding text describes package_group_name.gif.]

	
On Package Group Name, select the IBM WebSphere Application Server product to which you wish to upgrade. For example:

IBM WebSphere Application Server V8.5

[image: Surrounding text describes password_required.gif.]

	
On Password Required, enter valid credentials for your IBM ID to connect to the IBM download site by completing these fields:

	
User name


	
Password




[image: Surrounding text describes update_was85.gif.]




	
Note:

You can uncheck the Show Recommended only option to list all available fix packs.








	
Review the license agreement and accept the terms in order to continue.

[image: Surrounding text describes update_was85_1.gif.]

	
You can accept the recommended fix packs that are automatically checked.




	
Note:

The recommended fix packs may vary depends on the platform.







[image: Surrounding text describes update_was85_2.gif.]

	
On Features, use the checkboxes to select the components you want to install.

[image: Surrounding text describes update_was85_3.gif.]

	
On Features to Install, review the summary of components that you have selected and click the Update button.

[image: Surrounding text describes update_was85_4.gif.]

The update process downloads the fix pack from the IBM web site. The download speed depends on the network connections.

[image: Surrounding text describes update_was85_5.gif.]

	
Click the Finish button when the update is completed as indicated by this message:

The packages are updated.









3.10.3 Working with the HTTP Server Component

Use this procedure to install or update the IBM HTTP Server Component for WebSphere 8.5 or greater.

	
Launch the IBM Installation Manager using the IBMIM executable.


	
Select the Update option.

[image: Surrounding text describes update_http_1.gif.]

	
On Update, select this component for the version you want to install or update:

IBM HTTP Server

[image: Surrounding text describes update_http_2.gif.]

	
On Features to Install, review the summary of selected features and click Update.

[image: Surrounding text describes update_http_3.gif.]

	
Click the Finish button when the update is completed as indicated by this message:

The packages are updated.









3.10.4 Working with the Plug-ins Component

Use this procedure to install or update the Plug-ins Component for WebSphere 8.5 or greater.

	
Launch the IBM Installation Manager using the IBMIM executable.


	
Select the Update option.

[image: Surrounding text describes update_plugins_1.gif.]

	
On Update, select this component for the version you want to install or update:

Web Server Plug-ins for IBM WebSphere Application Server

[image: Surrounding text describes update_plugins_2.gif.]

	
On Features, review the summary of selected features and click Update.

[image: Surrounding text describes update_plugins_3.gif.]

	
Click the Finish button when the update is completed as indicated by this message:

The packages are updated.









3.10.5 Working with the Customization Toolbox Component

Use this procedure to install or update the Customization Toolbox Component to WebSphere 8.5 or greater.

	
Launch the IBM Installation Manager using the IBMIM executable.


	
Select the Update option.

[image: Surrounding text describes update_toolbox_1.gif.]

	
On Update, select this component for the version you want to install or update:

WebSphere Customization Toolbox

[image: Surrounding text describes update_toolbox_2.gif.]

	
On Features, verify the component you want to installed is selected..

[image: Surrounding text describes update_toolbox_3.gif.]

	
On Update, review the summary of selected features and click Update.

[image: Surrounding text describes update_toolbox_4.gif.]

	
Click the Finish button when the update is completed as indicated by this message:

The packages are updated.


	
Restart all HTTP Services.


	
Restart all Web Server instances.











3.11 Configuring the IBM Web Server Plug-in

After you have updated all software packages as described in the preceding section of this document entitled: Section 3.10, "Installing or Updating to WebSphere 8.5 Fix Pack", you must configure the plug-in. This process is performed through the IBM WebSphere Customization Toolbox. You must complete this configuration before you install the JD Edwards EnterpriseOne HTML Web Server.

	
Start the WebSphere Customization Toolbox using this navigation:

Start > Programs > IBM WebSphere > WebSphere Customization Toolbox V8.5 > WebSphere Customization Toolbox

[image: This image is described in surrounding text]

	
On WebSphere Customization Toolbox, Welcome, in the list of provided tools, highlight the Web Server Plug-ins Configuration Tool.


	
Click the Launch Selected Tool button.

[image: This image is described in surrounding text]

	
In the Web Server Plug-in Runtime Location section, click the Add button.

[image: This image is described in surrounding text]

	
On Add Web Server Plug-in Location, complete these fields:

	
Name

Enter a name for the plug-in location. For example:

IHS_webserver1


	
Location

Enter the location of your plug-in. The default plug-in directory is:

Z:\IBM\WebSphere\Plugins





	
Click the Finish button.

[image: This image is described in surrounding text]

	
In the upper half of the form (shown above), verify the plug-in location that you just defined is displayed in the Web Server Plug-in Runtime Locations section in the upper half of the form.

[image: This image is described in surrounding text]

	
In the lower half of the screen (shown above), click the Create button.

[image: This image is described in surrounding text]

	
On Web Server Selection, choose this radio button:

IBM HTTP Server V8.5.

[image: This image is described in surrounding text]

	
On Web Server Configuration File Selection, complete these fields:

	
Select the existing IBM HTTP Server httpd.conf file

Enter in the location of your httpd.conf file. For example:

z:\IBM\HTTPServer\conf\httpd.conf




	
Specify the Web server port

Specify a web server port that matches the port used by your HTTP server.





	
Click the Next button.

[image: This image is described in surrounding text]

You will receive the Non-Administrative user configuration limitation screen if you are not logged on as an administrative user.


	
Click the Next button.

[image: This image is described in surrounding text]

	
If you are signed on as an Administrative User, you will see the above screen. You can choose to create a user ID for IBM HTTP Server.


	
Click the Next button.

[image: This image is described in surrounding text]

	
You can choose whether to use a Windows service to run IBM HTTP Server administration server. It is recommended that you select to run the Server as a Windows Service. Optionally you can change the startup type to Manual if you are not going to use the HTTP Administration server often.

[image: This image is described in surrounding text]

	
On Web Server Definition name, specify a web server name. If you already have a web server defined (for example, webserver1), then you should use the same name here.

[image: This image is described in surrounding text]

For the purposes of this guide, it is assumed that the HTTP Server and WebSphere Application Server are located on the same machine. Therefore, on Configuration Scenario Selection, the radio button for (Local) Installation location of WebSphere Application Server is selected.


	
Use the Browse button to locate the installation location of the WebSphere Application Server. For example:

Z:\IBM\WebSphere\AppServer


	
Click the Next button.

[image: This image is described in surrounding text]

	
On WebSphere Application Server Profile Selection, use the drop-down menu in Available Profiles to select the WebSphere Application Server profile to configure with the current Web server plug-in and create the Web server definition. For example, an available profile might be named AppSvr01.

Note: If the Available Profiles field is blank and no options show on the drop down, you must Cancel from this procedure. Create a profile and either use the advanced option to automatically create a web server definition or manually create the web server in the IBM WebSphere Application Server Administrative Console. For more information on either option, refer to the IBM info center:

http://www-01.ibm.com/software/webservers/appserv/was/library/


	
Click the Next button.

[image: This image is described in surrounding text]

	
On Plug-in Configuration Summary, review the information for accuracy.


	
Click the Configure > button.

[image: This image is described in surrounding text]

	
On Plug-in Configuration Result, verify that the configuration completed successfully. If necessary, follow the instructions to correct any errors.


	
Click the Finish button.

[image: This image is described in surrounding text]

	
On WebSphere Customization Toolbox, with the Web Server Plug-in Configurations tab selected, verify that the server definition exists.









3.12 Setting the HTTP Server Properties

To use IBM WebSphere Application Server 8.5 properly with Oracle JD Edwards EnterpriseOne, you must set the HTTP server to automatically generate and propagate the plug-in. These steps briefly describe this process.

	
Log into the admin console for IBM WebSphere Application Server


	
Select Servers > Server Types > Web Servers.


	
Select your web server.


	
On the right hand side of the screen, select Additional Properties > Plug-in properties.

[image: This image is described in surrounding text]

	
Make any necessary changes and ensure the checkboxes are selected next to these two properties:

	
Automatically generate the plug-in configuration file


	
Automatically propagate plug-in configuration file





	
Click Apply.


	
Click the Save button to save all changes.









3.13 Manually Generating a Plug-in

Occasionally, you may to manually generate the web server plug-in. The most common error that requires manual plug-in generation is the "HTTP 404" when trying to access the software. This section briefly explains how to manually generate the plug-in.

	
Log in to the WebSphere Application Server Administration Console for your profile.


	
Select Server Types > Web Servers.

[image: This image is described in surrounding text]

	
Check the box next to the web server definition.


	
Click the Generate Plug-in button.


	
Click the Propagate Plug-in button.


	
Log off of the Admin Console.







	
Note:

Federated (Clustered) Web Servers. If you are using WebSphere Application Server and running JD Edwards EnterpriseOne as part of a federated (or clustered) web server, you may need to regenerate the WebSphere global plugin configuration after deploying the newest tools release. This is required when new servlets have been added to the tools release you are deploying.
To update (regenerate) plugins, refer to the following procedure.









To update (regenerate) and propagate the global web server plugin configuration:

	
Log on to the Deployment Manager Administration Console using the Dmgr01 profile.

[image: Surrounding text describes was_update_global_plugins.gif.]

	
Expand the Environment node and select Update global Web server plug-in configuration.


	
Review the content in the right-hand pane and note the location of the plug-in file in the description. For example, the description might say:

The global plugin-cfg.xml file is placed in the %was_profile_home%/config/cells directory.


	
Click the OK button.









3.14 Manually Editing the HTTP Configuration File




	
Caution:

You must perform this step in order for JD Edwards EnterpriseOne HTML Server to work correctly.







To manually edit the HTTP configuration file (httpd.conf):

	
Locate your httpd.conf file. Typically the file is located in this directory:

Z:\IBM\WebSphere\HTTPServer\config


	
Open the file with an ASCII editor.


	
Assuming the location of your httpd.conf is that shown in the previous step, add the following lines to the bottom of the file:

LoadModule was_ap22_module "Z:\IBM\WebSphere\Plugins\bin\32bits\mod_was_ap22_http.dll"

WebSpherePluginConfig "Z:\IBM\WebSphere\Plugins\config\webserver1\plugin-cfg.xml"


	
Save and close the httpd.conf file.


	
Stop and restart HTTP Server from the Windows Services panel.











4 Installing and Configuring WebSphere 7.0

This chapter describes how to install and configure WebSphere 7.0. It contains the following topics:

	
Section 4.1, "Performing the Pre-installation Procedure"


	
Section 4.2, "Installing WebSphere Application Server 7.0 (Using Network Deployment CD or Downloaded Image)"


	
Section 4.3, "Installing the IBM HTTP Server 7.0"


	
Section 4.4, "Installing IBM HTTP Server Plug-ins for WebSphere Application Server"


	
Section 4.5, "Installing the WebSphere Update Installer"


	
Section 4.6, "Installing WebSphere 7.0 Fix Pack 29"


	
Section 4.7, "Installing the IBM HTTP Server Fix Pack"


	
Section 4.8, "Installing the WebSphere 7.0 Plug-ins Fix Pack"


	
Section 4.9, "Verifying the Versions of Installed WebSphere Products"


	
Section 4.10, "Starting the WebSphere Application Server"


	
Section 4.11, "Stopping the WebSphere Application Server"


	
Section 4.12, "Determining the Name and Status of the WebSphere Application Server"


	
Section 4.13, "Starting the IBM HTTP Server"


	
Section 4.14, "Stopping the IBM HTTP Server"


	
Section 4.15, "Accessing the WebSphere Administration Console"


	
Section 4.16, "Testing the WebSphere and IBM HTTP Server Installation"


	
Section 4.17, "Generating and Propagating WebSphere Plug-ins (optional)"


	
Section 4.18, "Creating a New Application Server Profile (optional)"


	
Section 4.19, "Deleting a Profile (optional)"


	
Section 4.20, "Adding a New Web Server for a New Profile (optional)"






4.1 Performing the Pre-installation Procedure

Before you install WebSphere, you must first set up a local user account that is in the Administrative group and has these advanced user rights:

	
Act as part of operating system


	
Create a token object.


	
Log on as a service


	
Replace a process level token




To set up a local user account with the above user rights, navigate to:

Control Panel > Administrative Tools > Local Security Policy > Local Policies > Users Rights Assignment

On User Rights Assignment, double-click one of the user rights, click Add, select a local user account from the list, and click OK. Repeat this process for the remaining user rights.






4.2 Installing WebSphere Application Server 7.0 (Using Network Deployment CD or Downloaded Image)




	
Note:

It is important to follow the exact sequence of steps in this procedure.







Complete these steps to install the WebSphere Application Server version 7.0, and then install the EnterpriseOne Web Server to that installation. The WebSphere 7.0 Network Deployment CD may be used to install WebSphere Application Server for a base or standalone configuration.




	
Note:

The typical IBM WebSphere installation includes the Application Server itself, HTTP Server, and the Plug-in components. You must install all these components to ensure WebSphere Application Server 7.0 is functioning correctly. For any additional requirements and Fix Packs once the basic install is completed, review the minimum technical requirements (MTRs) as described in Accessing Certifications (formerly Minimum Technical Requirements) in this document.







	
Insert the WebSphere Application Server Network Deployment CD, Version 7.0 (32-bit) or extract the downloaded image into a temporary location.


	
Run the launchpad executable from the extracted directory:

cd x:\dump\was7_windows\cd1

x:\dump\was7_windows\cd1 > launchpad.exe

where x: is the drive on which you downloaded the WebSphere 7.0 image.

[image: This image is described in surrounding text.]

	
From that launchpad window, select the first link on the right panel:

Launch the installation wizard for WebSphere Application Server Network Deployment

[image: This image is described in surrounding text.]

[image: This image is described in surrounding text.]

	
On the Welcome panel, click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Software License Agreement, review the License Agreement and select a radio button to accept or decline.

If you chose to accept, click the Next button to continue.

If you do not accept the terms of the license agreement, you cannot continue with the installation.

[image: This image is described in surrounding text.]

	
On System Prerequisites Check, the installer performs a quick system requirements check on the server. Once the check is complete and successful, click the Next button to continue.

[image: This image is described in surrounding text.]

	
On the Optional Features Installation screen, click the Next button to continue.




	
Tip:

For production environments, it is recommended that you not enable the Install the Sample application check box.
You should enable the check box for non-English support for the WebSphere Administrative Console if applicable to your installation.









[image: This image is described in surrounding text.]

	
On Installation Directory, enter or browse to a valid location where you want to install WebSphere Application Server Network Deployment. For example:

z:\IBM\WebSphere\AppServer


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On WebSphere Application Server Environments, select Application Server to create a standalone application server profile and then click the Next button to continue.




	
Note:

The Application Server environment will create a default stand-alone application server called AppSrv01 during the installation. To use federated nodes configuration, select Cell environment to create a deployment manger (such as Dmgr01) and a managed node (for example, AppSrv01) during the installation.







[image: This image is described in surrounding text.]

	
On Enable Administrative Security, the check box for the application server profile is checked by default. You can choose either to:

	
Clear the check box for Enable administrative security to disable server administrative security, or


	
If the check box is enabled for Enable administrative security, server administration security will be enabled and you must enter the User ID and Password

When you enable the check box the fields on this screen are enabled and you must enter valid credentials for the WebSphere administrator for this installation.







	
Tip:

JD Edwards EnterpriseOne Business Services Server. If you are using these instructions to install a JD Edwards EnterpriseOne Business Services Server into this WebSphere instance, you must enable administrative security.








	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Installation Summary, review the information and click the Next button to begin the installation of WebSphere Application Server Network Deployment.




	
Note:

You should enable the check box for Verify my permissions to perform the installation in order for the installer to validate the permissions required for installation of the product.







[image: This image is described in surrounding text]




	
Note:

On Installation Results, you can click on the AboutThisProfile.txt link to see the port assignment for this profile. Note the Administrative console port on which AppSrv01 will be running (for example, 9060). You can use Profile Management Tool to create as many profiles as you like. Each profile is a separate instance of the WebSphere running on a different set of ports.
A sample of the contents of the AboutThisProfile.txt file is shown below:

[image: This image is described in surrounding text.]








	
On Installation Results, click Finish.

[image: This image is described in surrounding text.]

The First steps menu is launched.


	
On the First steps menu, click Installation verification to verify the installation.

After you click Installation verification, you can verify the success of the installation by reviewing the contents of the resulting display. For example:

[image: This image is described in surrounding text.]

	
Ensure that the Installation Verification utility completes with a success message.


	
Close the First steps output and click Exit on the First steps screen.

This completes the profile creation activity.









4.3 Installing the IBM HTTP Server 7.0




	
Note:

If you are planning to use Microsoft Internet Information Services (IIS), you can skip this section and continue to Installing IBM HTTP Server Plug-ins for WebSphere Application Server.










	
Note:

Although the IBM HTTP Server is integrated into the WebSphere Application Server, the installation is a separate process.







To install the IBM HTTP Server:

	
Insert the WebSphere Application Server Supplement CD, Version 7.0 (32-bit) or extract the downloaded image (if you haven't done so already).


	
Run the install executable that is located in the IHS directory from the extracted location by typically using these commands:

cd x:\dump\was7_windows\sup1\IHS

x:\dump\was7_windows\sup1\IHS > install.exe

where x: is the drive on which you downloaded the WebSphere 7.0 image.

[image: This image is described in surrounding text.]

	
On Welcome, click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Software License Agreement, review the License Agreement and choose an option to accept or decline.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On System Prerequisites Check, the installer performs a quick system requirements check on the server. Once the check is complete and successful, click the Next button to continue.

[image: This image is described in surrounding text.]

	
For the install location, enter a valid value for your IBM HTTP Server installation directory. Use a value such as:

z:\IBM\HTTPServer


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Port Values Assignment, use the default port or enter different ports.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Windows Service, complete these fields:


	Field	Value
	Run IBM HTTP Server as a Windows Service	Checked
	Run the Application Server process as a Windows Service	Checked
	Log on as a local system account	Selected
	Startup Type	Use the pull-down to choose either manual or automatic.






	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On HTTP Administration Server Authentication, the check box enabling HTTP server administration security is checked by default. You can choose either to:

	
Clear the check box for Create a user ID for IBM HTTP administration server authentication to disable HTTP server administration security, or


	
If the check box is enabled for Create a user ID for IBM HTTP administration server authentication, HTTP server administration security will be enabled and you must enter the User ID and Password





	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On IBM HTTP Administration Server Plug-in For IBM WebSphere Application Server, clear the check box for Install the IBM HTTP Server Plug-in for IBM WebSphere Application Server to disable the silent install of the plug-in at this time. The installation of IBM HTTP Server Plug-in for IBM WebSphere Application Server will be described in the section Installing IBM HTTP Server Plug-ins for WebSphere Application Server.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On the summary screen, click the Next button to begin the installation.

[image: This image is described in surrounding text.]

	
On the successfully installed screen, click Finish.









4.4 Installing IBM HTTP Server Plug-ins for WebSphere Application Server

With the IBM HTTP Server or Microsoft Internet Information Services (IIS) successfully installed, the final portion of the WebSphere Application Server installation is to install WebSphere Plug-ins.

Prior to installing WebSphere Plug-ins, it is recommended to ensure the IBM HTTP Server services (Apache) or Microsoft IIS services are not already running.

To install WebSphere Plug-ins:

	
Insert the WebSphere Application Server Supplement CD, Version 7.0 (32-bit) or extract the downloaded image (if you haven't done so already).


	
Run the install executable in the plugin directory. For example:


cd Z:\dump\was7_windows\sup1\plugin
Z:\dump\was7_windows\sup1\plugin > install.exe





	
Note:

The syntax of the mount command can vary by platform, and is not required for Sun platforms.







[image: This image is described in surrounding text.]

	
On the Welcome screen, you can deselect all "learning" options and click the Next button to begin the wizard.

[image: This image is described in surrounding text.]

	
On Software License Agreement, review the License Agreement and choose an option to accept or decline.


	
Click the Next button to continue (not available if license agreement is not accepted).

[image: This image is described in surrounding text.]

	
On System Prerequisites Check, the installer performs a verification of system requirements.

After the installer indicates the check was successful, click the Next button to continue.

[image: This image is described in surrounding text.]

[image: This image is described in surrounding text.]

	
On Select the Web server to configure, select only one of the following radio buttons:

IBM HTTP Server V7

Miscrosoft Internet Information Service V7

Miscrosoft Internet Information Service V6




	
Note:

All plug-in binaries are installed, but only the selected Web server will be configured.








	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Select installation scenario, if your WAS server is located on the same machine on which you are installing, select this radio button:

WebSphere Application Server machine (local)

If your WAS server is located on a different machine than the one on which you are running the installer, select this radio button:

Web server machine (remote)


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Web server plug-ins installation location, enter a directory. The default directory is:

z:\IBM\HTTPServer\Plugins


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Installation location of WebSphere Application Server V7.0, enter a directory. For example:

z:\IBM\WebSphere\AppServer


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Select the existing IBM HTTP Server httpd.conf file, enter a directory path. For example:

z:\IBM\HTTPServer\conf\httpd.conf




	
Note:

This field is not available for IIS.







You must also specify the Web Server port. Typically you can accept the default value of 80 for the both the IBM HTTP and Microsoft IIS servers.




	
Note:

The plug-ins installer directly modifies the IBM HTTP Server configuration file with the information you specify on this screen.








	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Specify a unique Web Server definition name, enter the name of your IBM HTTP or Microsoft IIS Server to allow the WebSphere Administration Console to administer the IBM HTTP or Microsoft IIS Server configuration and status.




	
Tip:

In order to avoid confusion in installations with multiple web servers on multiple ports, it is good practice to use the following naming convention:
webserver<port_number>

For example, the name webserver80 indicates the webserver is on port 80.










	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Web Server plugin-cfg.xml file, you can accept the default location for the plugin-cfg.xml file.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
The installation wizard detects the default profile (such as AppSrv01) that does not have a Web server defined. Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On the Summary screen, click the Next button to begin the installation.

[image: This image is described in surrounding text.]

	
The installation wizard shows that a Web server definition is created for the default Application server profile (such as AppSrv01).


	
Click the Next button to proceed.

The installation wizard launches a web browser with more detailed information about the Plug-ins road map. You can close the browser at any time or return to the installation wizard.

[image: This image is described in surrounding text.]

	
On the completion screen, click Finish to exit the WebSphere Plug-ins installation wizard.









4.5 Installing the WebSphere Update Installer

The Update Installer for WebSphere Software includes a new installation program for IBM WebSphere Version 7.0, Installation Wizard starting with Fix Pack 7. The Update Installer is backwards compatible. You should download the Update Installer that match with your WebSphere product. You can use a single installation of the Update Installer to install maintenance packs on all the WebSphere software products such as WebSphere Application Server, Java SDK, IBM HTTP Server, and Web server plug-ins.

Before you can install Refresh or Fix pack for WebSphere software, you need to install the Update Installer engine as described in this procedure.




	
Note:

Make sure all WebSphere processes including IBM HTTP Server V7 are not running before starting Update Installer installation.







This document uses Fix Pack 29 (7.0.0.29) to describe the process of installing WebSphere Fix Pack. Check the Certification for the latest supported WebSphere Fix Pack for the JD Edwards EnterpriseOne HTML Web Server (refer to Chapter 1, "Accessing Certifications (formerly Minimum Technical Requirements)").

To install the WebSphere update installer:

	
Download the Update Installer software from IBM web site.


	
Extract the downloaded image.


	
From the downloaded image run the install executable using these commands:

cd x:\dump\was7_windows\sup1\UpdateInstaller

x:\dump\was7_windows\sup1\UpdateInstaller > install.exe

where x: is the drive where you downloaded the Update Installer.

[image: This image is described in surrounding text.]

	
On the Welcome screen, click the Next button to begin the wizard.

[image: This image is described in surrounding text.]

	
On Software License Agreement, review the License Agreement and choose an option to accept or decline.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On System Prerequisites Check, the Installer performs a verification of system requirements.


	
After the Installer indicates the check was successful, click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Directory Name, enter a valid value for the Update Installer installation directory. For example:

z:\IBM\WebSphere\UpdateInstaller




	
Note:

To facilitate maintenance, it is recommended that you install the Update Installer under the WebSphere root directory. For example:
z:\IBM\WebSphere\UpdateInstaller










	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Installation Summary, click the Next button to begin the installation.

[image: This image is described in surrounding text.]

	
On Installation Complete, deselect the check box for Launch IBM Update Installer for WebSphere software on exit.


	
Click the Finish button.









4.6 Installing WebSphere 7.0 Fix Pack 29




	
Note:

This document uses Fix Pack 29 (7.0.0.29) to describe the process of installing WebSphere Fix Pack. Check the Certification for the latest supported WebSphere Fix Pack for the JD Edwards EnterpriseOne HTML Web Server (refer to Chapter 1, "Accessing Certifications (formerly Minimum Technical Requirements)").







To install the WebSphere 7.0 Fix Pack:

	
Ensure that all WebSphere and HTTP Services are stopped prior to updating the software.


	
Download all the fix pack files to the "maintenance" directory under the installation directory of the Update Installer, such as: Z:\IBM\WebSphere\UpdateInstaller\maintenance

The complete list of WebSphere 7.0 Fix Pack 29 (7.0.0.29) files is shown in the screen sample below:

[image: This image is described in surrounding text.]




	
Note:

You do not need to uncompress these files, just put them in the "maintenance" directory.








	
Run the update executable from the UpdateInstaller directory using these commands:

cd x:\IBM\WebSphere\UpdateInstaller

x:\IBM\WebSphere\UpdateInstaller > update.exe

where x: is the drive on which you downloaded the Update Installer.

[image: This image is described in surrounding text.]

	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On the Product selection screen, use the drop down to select the installation location of the WebSphere Application Server. For example:

Z:\IBM\WebSphere\AppServer


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Maintenance Operation Selection, select the following radio button:

Install maintenance package


	
Click the Next button to continue.

The installer inspects the UpdateInstaller directory for maintenance packages (.pak files); specifically in the maintenance sub-directory.

[image: This image is described in surrounding text.]

	
On Maintenance Package Selection, validate the directory name that was located by the Installer wizard.

[image: This image is described in surrounding text.]

	
On Available Maintenance Package to Install, check the WAS and WASSDK fix pack files since the WebSphere Application Server components are being updated.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Installation Summary, review the information and click the Next button to begin the installation.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Installation Complete, Success, click the Relaunch button to relaunch the wizard and install the HTTP server components.









4.7 Installing the IBM HTTP Server Fix Pack




	
Note:

If you are planning to use Microsoft Internet Information Services (IIS), you can skip this section and continue to Installing the WebSphere 7.0 Plug-ins Fix Pack.







To install the IBM HTTP Server Fix Pack:

	
Ensure that all WebSphere and HTTP Services are stopped prior to updating the software.


	
Download and uncompress the fix pack file for the IBM HTTP Server to the \UpdateInstaller\maintenance directory.

For example:

7.0.0-WS-IHS-WinX32-FP00000029.pak


	
Once the wizard has restarted, select the HTTP server components.

[image: This image is described in surrounding text.]

	
On the Welcome screen, click the Next button to begin the Update Installer wizard.

[image: This image is described in surrounding text.]

	
On Product Selection, use the drop down to select the installation location of the IBM HTTP Server. For example:

Z:\IBM\HTTPServer


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Maintenance Operation Selection, select this radio button:

Install maintenance package


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Maintenance Package Directory Selection, validate the directory path that was located by the Installer wizard.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Available Maintenance Package to Install, ensure that the available IHS and WASSDK fix pack files are checked since the IBM HTTP Server components are being updated.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Installation Summary, click the Next button to begin the installation.

[image: This image is described in surrounding text.]

	
On Installation Complete, verify that the proper maintenance packages for the IBM HTTP Server were successfully installed.


	
Click the Relaunch button and continue to the next section to install WebSphere Plug-ins Fix Pack.









4.8 Installing the WebSphere 7.0 Plug-ins Fix Pack




	
Note:

It is very important to following the exact sequence of steps in this procedure.







To install the WebSphere 7.0 Plug-ins Fix Pack:

	
Ensure that all WebSphere and IBM HTTP or Microsoft IIS Services are stopped prior to updating the software.


	
Download and copy the fix pack file for the WebSphere Plug-ins to the \UpdateInstaller\maintenance directory.

For example:

7.0.0-WS-PLG-WinX32-FP00000029.pak


	
Run the update executable from the copied UpdateInstaller directory using these commands:

cd Z:\IBM\WebSphere\UpdateInstaller

Z:\IBM\WebSphere\UpdateInstaller > update.exe

[image: This image is described in surrounding text.]

	
Once is wizard is restarted, select the Plugins component.

[image: This image is described in surrounding text.]

	
On Product Selection, use the drop down to select the installation location of the Web server plugin. For example:

Z:\IBM\HTTPServer\Plugins


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Maintenance Operation Selection, select the following radio button:

Install maintenance package


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Maintenance Package Directory Selection, validate the directory path that was located by the Installer wizard.




	
Note:

The installer inspects the \UpdateInstaller\maintenance directory for maintenance packages (.pak files).








	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Available Maintenance Package to Install, ensure that the PLG and WASSDK fix pack files are checked since the WebSphere Plugin components are being updated.


	
Click the Next button to continue the update for the WebSphere Plug-ins.

[image: This image is described in surrounding text.]

	
On the Installation Summary screen, review the information and click the Next button to begin the installation.

[image: This image is described in surrounding text.]

	
After the Plug-ins update is complete, the Success screen indicates the status of the maintenance package installation.


	
Click the Finish button to exit the Update Installer wizard.









4.9 Verifying the Versions of Installed WebSphere Products

This section describes how to verify the versions of these installed WebSphere products:

	
WebSphere Application Server


	
IBM HTTP Server


	
WebSphere Plugins for IBM WebSphere Application Server






4.9.1 WebSphere Application Server

Use this procedure to verify the version of the IBM WebSphere Application Server.

	
Open a Windows Command window


	
Navigate to this folder:

Z:\IBM\WebSphere\AppServer\bin


	
From the above folder, execute this batch file:

versionInfo.bat

Verify the installed version of the IBM WebSphere Application Server is 7.0.0.29 as shown in the example below:

[image: This image is described in surrounding text.]








4.9.2 IBM HTTP Server

Use this procedure to verify the version of the IBM HTTP Server.

	
Open a Windows Command window


	
Navigate to this folder:

Z:\IBM\WebSphere\AppServer\bin


	
From the above folder, execute this batch file:

versionInfo.bat

Verify the installed version of the IBM HTTP Server is 7.0.0.29 as shown in the example below:

[image: This image is described in surrounding text.]








4.9.3 WebSphere Plugins for IBM WebSphere Application Server

Use this procedure to verify the version of the IBM HTTP Server.

	
Open a Windows Command window


	
To verify the Web server plugins for IBM WebSphere Application Server, navigate to this folder:

Z:\IBM\HTTPServer\Plugins\bin


	
From the above folder, execute this batch file:

versionInfo.bat

Verify the installed version of the Web server plugins for IBM WebSphere Application Server is 7.0.0.29 as shown in the example below:

[image: This image is described in surrounding text.]










4.10 Starting the WebSphere Application Server




	
Note:

By default, WebSphere Application Server 7.0 creates and configures a default server named server1 during installation. If you named your server something other than the default value, then substitute that name for server1 in the following steps.







To start the WebSphere Application Server:

	
Start a command prompt.


	
Navigate to the <websphere_install_dir>\AppServer\profiles\profile_name\bin directory. For example:

cd Z:\IBM\WebSphere\AppServer\profiles\AppSrv01\bin


	
Issue the command startServer followed by the Application Server name. For example:

Z:\IBM\WebSphere\AppServer\profiles\AppSrv01\bin > startServer server1




This command is case sensitive.




	
Tip:

The Application Server can also be started through the Windows Services Applet. Each profile that you configured will have a corresponding service that is automatically created when you created the profile.










	
Note:

Starting with Tools Release 8.97, you can use the Server Manager to start the WebSphere process.












4.11 Stopping the WebSphere Application Server




	
Note:

By default, WebSphere Application Server 7.0 creates and configures a default server named server1 during installation. If you named your server something other than the default value, then substitute that name for server1 in the following steps.







To stop the WebSphere Application Server:

	
Start a command prompt.


	
Navigate to the <websphere_install_dir>\AppServer\profiles\profile_name\bin directory. For example:

cd Z:\IBM\WebSphere\AppServer\profiles\AppSrv01\bin


	
Issue the command stopServer followed by the Application Server name. For example:

stopServer server1




This command is case sensitive.




	
Note:

If administrative security has been enabled for the WebSphere Application Server profile then use the following command to stop the servers:
Z:\IBM\WebSphere\AppServer\profiles\AppSrv01\bin > stopServer server1 user <admin_user_name> -password <admin_user_password>












	
Tip:

The Application Server can also be stopped through the Windows Services Applet. Each profile that you configured will have a corresponding service that is automatically created when you created the profile.










	
Note:

Starting with Tools Release 8.97, you can use the Server Manager to stop the WebSphere process.












4.12 Determining the Name and Status of the WebSphere Application Server

To determine the name and status of any or all WebSphere Application servers:

	
Start a command prompt.


	
Navigate to the <websphere_install_dir>\AppServer\profiles\profile_name\bin directory. For example:

cd Z:\IBM\WebSphere\AppServer\profiles\AppSrv01\bin


	
Issue the command serverStatus followed by the Application Server name (or with the all option to view the status of all the servers in the profile). For example, to view the status of all Application Servers:

Z:\IBM\WebSphere\AppServer\profiles\AppSrv01\bin > serverStatus -all




	
Note:

If administrative security has been enabled for the WebSphere Application Server profile, you must use the following command to check the status of the servers:
Z:\IBM\WebSphere\AppServer\profiles\AppSrv01\bin > serverStatus all user <admin_user_name> -password <admin_user_password>

















4.13 Starting the IBM HTTP Server

To start the IBM HTTP Server:

	
Start a command prompt.


	
Navigate to the <ibm_http_server_location>\bin directory and issue the start command with the -k option. For example:

cd Z:\IBM\HTTPServer\bin

apache.exe -k start




This command is case sensitive.




	
Tip:

The IBM HTTP Server can also be started through the Windows Services Applet.










	
Note:

Starting with Tools Release 8.97, you can use the Server Manager to start the IBM HTTP Server process.












4.14 Stopping the IBM HTTP Server

To stop the IBM HTTP Server:

	
Start a command prompt.


	
Navigate to the <ibm_http_server_location>\bin directory and issue the stop command with the -k option. For example:

cd Z:\IBM\HTTPServer\bin

apache -k stop




This command is case sensitive.




	
Tip:

The IBM HTTP Server can also be stopped through the Windows Services Applet.










	
Note:

Starting with Tools Release 8.97, you can use the Server Manager to stop the IBM HTTP Server process.










	
Note:

Below is an example of the console indicating that the IBM HTTP Server is successfully stopped: [image: This image is described in surrounding text.]












4.15 Accessing the WebSphere Administration Console

The WebSphere Administration Console is completely web-based and can be accessed from any supported web browser. The default URL is:

http://<machinename>:<profile_port>/admin

where machine_name is the name of the machine on which WebSphere Application Server has been installed, and

where profile_port was defined during the profile creation in the profile creation wizard. For the first profile created, the default value is usually 9060.

To access the WebSphere Administration Console on the installed machine:

	
Ensure that the WebSphere Application Server (default name is server1) is started.


	
Start a web browser.


	
Enter this URL to access the WebSphere Administration Console:

http://localhost:9060/admin




	
Tip:

If the port number is unknown and the default port is not working, the AboutThisProfile.txt file contains the key Administrative console port, which typically lists the assigned admin port number. Typically this file is located in this directory:
<websphere_installation_root>\AppServer\profiles\<profile_name>\logs\ AboutThisProfile.txt









[image: This image is described in surrounding text.]

	
On the Log in to the console screen, enter a valid or new user.

[image: This image is described in surrounding text.]

Upon successful logon, the WebSphere Application Server welcome screen is displayed. You can use this application to manage your WebSphere servers and related machines.









4.16 Testing the WebSphere and IBM HTTP Server Installation

To test the WebSphere Administration Console:

	
Ensure that the WebSphere Application Server (default name is server1) is started.


	
Ensure that the IBM HTTP Server is started.


	
Start a web browser.


	
Enter this URL to test the WebSphere Administration Console:

http://<machine_name>:<http_port>/snoop

where machine_name is your server, and

where http_port is the port of your IBM HTTP Server. The default value is 80.

For example:

http://localhost:80/snoop

[image: This image is described in surrounding text.]

Upon successful execution, the resulting page should display information similar to the above. This indicates that your WebSphere Application Server is successfully installed and functioning.









4.17 Generating and Propagating WebSphere Plug-ins (optional)




	
Note:

This section is informational only and is not required before you install the Oracle JD Edwards EnterpriseOne HTML Web server.







Whenever you install new enterprise applications, or create new virtual hosts, you must regenerate Web Server plug-ins. If your WebSphere installation is on a single machine, you can generate plug-ins from the WebSphere Administrative console. However, your configuration is across multiple machines, you might need to manually generate plug-ins.

This section describes these topics:

	
Generating WebSphere Plug-ins


	
Propagating WebSphere Plug-ins






4.17.1 Generating WebSphere Plug-ins

To generate WebSphere plug-ins:

	
Log on to the WebSphere Administrative console as described in Accessing the WebSphere Administration Console.


	
On the left hand navigation pane, select Servers > Server Types > Web servers

[image: This image is described in surrounding text.]

	
Click the check box next to the webserver definition for which you want to regenerate plug-ins.


	
To generate plug-ins, click the Generate Plug-in button, which is located above the webserver definition.

The Plug-in file plugin-cfg.xml is regenerated in place, typically at this location:

Z:\IBM\WebSphere\AppServer\profiles\AppSrv01\config\cells\denicint2Node01Cell\nodes\ denicint2Node01\servers\webserver80

A status message will display under the Web servers section.

[image: This image is described in surrounding text.]

	
You must restart the IBM HTTP or Microsoft IIS Server for any plug-in changes to take effect.









4.17.2 Propagating WebSphere Plug-ins

To propagate the generated WebSphere plug-ins:

	
Log on to the WebSphere Administrative console as described in Accessing the WebSphere Administration Console.


	
On the left hand navigation pane, select Servers > Server Types > WebServers.


	
Click the check box next to the webserver definition for which you want to propagate plug-ins.


	
To generate plug-ins, click the Propagate Plug-in button, which is located above the webserver definition.

The Plug-in file plugin-cfg.xml is propagated in place, typically at this location:

x:\IBM\HTTPServer\Plugins\config\webserver80\plugin-cfg.xml

where x: is the drive on which the IBM HTTP Server is installed.

A status message displays under the Web servers section as indicated in this screenshot sample:

[image: This image is described in surrounding text.]






	
Note:

Federated (Clustered) Web Servers. If you are using WebSphere Application Server and running JD Edwards EnterpriseOne as part of a federated (or clustered) web server, you may need to regenerate the WebSphere global plugin configuration after deploying the newest tools release. This is required when new servlets have been added to the tools release you are deploying.
To update (regenerate) plugins, refer to the following procedure.









To update (regenerate) and propagate the global web server plugin configuration:

	
Log on to the Deployment Manager Administration Console using the Dmgr01 profile.

[image: Surrounding text describes was_update_global_plugins.gif.]

	
Expand the Environment node and select Update global Web server plug-in configuration.


	
Review the content in the right-hand pane and note the location of the plug-in file in the description. For example, the description might say:

The global plugin-cfg.xml file is placed in the %was_profile_home%/config/cells directory.


	
Click the OK button.











4.18 Creating a New Application Server Profile (optional)




	
Note:

This section is informational only and is not required before you install Oracle JD Edwards EnterpriseOne HTML Web server.







To create a new application server profile:

	
Launch the profile creation wizard. For example:

cd Z:\IBM\WebSphere\AppServer\bin\ProfileManagement

Z:\IBM\WebSphere\AppServer\bin\ProfileManagement > pmt.bat

[image: This image is described in surrounding text.]

	
On the Welcome screen, click the Launch Profile Management Tool button.

[image: This image is described in surrounding text.]

	
On Profile Management Tool, click the Create button to begin the profile configuration.

[image: This image is described in surrounding text.]

	
On Environment Selection, select Application Server as the type of environment to create.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Profile Creation Options, select the Typical profile creation radio button.


	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
Administrative security is enabled for the profile by default. Clear the check box to disable administrative security or enter the user name and password.

On Enable Administrative Security, the check box for the application server profile is checked by default. You can choose either to:

	
Clear the check box for Enable administrative security to disable server administrative security, or


	
If the check box is enabled for Enable administrative security, server administration security will be enabled and you must enter the User ID and Password





	
Click the Next button to continue.

[image: This image is described in surrounding text.]

	
On Profile summary, review your selections.


	
Click the Create button to start the profile creation.

[image: This image is described in surrounding text.]

When complete, the installer displays the message: The Profile Management Tool created the profile successfully. It is not necessary to Launch the First Steps console at this time; you can clear the check box, which is checked by default.


	
Click the Finish button to complete the wizard and the profile configuration and proceed to the final Profiles screen.

[image: This image is described in surrounding text.]

	
Exit the Profile Management Tool by choosing File > Exit.









4.19 Deleting a Profile (optional)

This section is provided as reference in case you need to delete a WebSphere base or Network Deployment profile.

	
From a command prompt, change to this directory:

cd Z:\IBM\WebSphere\AppServer\bin


	
To delete a profile, issue this command:

manageprofiles delete profileName <profile_name>

where profile_name is the name of the profile to be deleted.

If the profile_name is valid, and the command successfully executed, the system returns this message:


INSTCONFSUCCESS: Success: The profile no longer exists.


When you delete a profile, the profile and its directory are deleted, except for the logs directory. You must manually delete the logs directory and then delete the profile directory.









4.20 Adding a New Web Server for a New Profile (optional)

Each profile should be associated with a Web Server. The EnterpriseOne HTML Web Server install fails if it does not find a webserver associated with the profile specified during the install. If the newly created profile is an ND profile, you can create the Web Server by using the button Create a New Web Server from the Web Servers page on the WebSphere Administrator Console. However, if the newly created profile is not an ND profile, the option to Create a New Web Server is not available. Instead, you must create a new web server must be created from the command line.

To add a new web server for a new profile from the command line:

	
Locate a copy of this Web Server configuration file which is typically located in this directory with this name:

x:\IBM\HTTPServer\Plugins\bin\configurewebserver<webserver_port>.bat

where x: is the drive on which you installed the IBM HTTP Server, and

where <webserver_port> is the port on which the IBM HTTP Server is installed.


	
Make a copy of the configurewebserver<webserver_port>.bat file assigning a new port value to the copy. For example, assuming you have changed directory to x:\IBM\HTTPServer\Plugins\bin:

copy configurewebserver80.bat configurewebserver81.bat

Do not manually copy the configurewebserver1.bat file to the specific profile directory.


	
Edit the new configuration file (configurewebserver81.bat) file that resides in the x:\IBM\HTTPServer\Plugins\bin directory to change the settings to be unique to and specific to your newly created profile.

Change the settings to be unique to and specific to your newly created profile.

A sample file is provided below where:

the newly created profile is called AppSrv02, and

the new webserver will be called webserver81, and

the name of the node that we specified for our new profile is SERVERNode02, and

the name of the server itself is SERVER.domain.com.

The above is illustrated by the bolded settings in this sample file:


"Z:/IBM/WebSphere/AppServer/profiles/AppSrv02/bin/wsadmin.bat" 
%PROFILE_NAME_PARAMETER% %WSADMIN_USERID_PARAMETER% 
%WSADMIN_PASSWORD_PARAMETER% -conntype NONE -f 
"Z:\IBM\WebSphere\AppServer\bin\configureWebserverDefinition.jacl"
webserver81 IHS "Z:\\IBM\\HTTPServer" 
"Z:\\IBM\\HTTPServer\\conf\\httpd.conf" 81 MAP_ALL 
"Z:\\IBM\\HTTPServer\\Plugins" managed denicint2Node02 
denicint2.mlab.jdedwards.com windows





	
Note:

Where the original settings for these bolded entries were probably something similar to these:
	
AppSrv01


	
webserver80


	
80


	
SERVERNode01













	
Save the file.


	
From the directory where the batch file exists, execute it using this command:

configurewebserver81.bat

where x: is the drive on which your plugins are installed.

The console displays these messages when the batch file is running and finishes:

[image: This image is described in surrounding text.]

[image: This image is described in surrounding text.]

	
Verify your newly created Web Server is created by logging into the WebSphere Admin Console and clicking on Web Servers. For example:

[image: This image is described in surrounding text.]










5 Running the HTML Server

This chapter contains the following topics:

	
Section 5.1, "Starting the HTML Server"


	
Section 5.2, "Stopping the HTML Server"


	
Section 5.3, "Accessing the HTML Server"


	
Section 5.4, "Generating Serialized Objects for the HTML Server"


	
Section 5.5, "Configuring the HTML Server for Non-Western European Languages"


	
Section 5.6, "Enabling the Browser Side Debugging Feature on the Web Client"


	
Section 5.7, "Customizing the Disclaimer for the Sign-In Page"


	
Section 5.8, "Setting Up Quick Links for Pervasive Device Support"


	
Section 5.9, "Clearing File Attachments from the Browser Cache"







	
Tip:

In order to enable any modifications, you should always stop and restart the Application Server any time you modify the configuration.










	
Note:

Beginning with Tools Release 8.97, many administrative tasks (such as starting and stopping services) for both the HTTP server and the JD Edwards EnterpriseOne HTML Web server can be performed through the Server Manager Console.









5.1 Starting the HTML Server

The JD Edwards EnterpriseOne HTML Server is installed in the instance of the application server that you defined when you installed the Web Server (for example, AS_JS_81). Complete this task to start the server.

To start the HTML Server:

	
Start the Server Manager console.


	
Select the Server and Instance you want to start.


	
Select the Start button.









5.2 Stopping the HTML Server

The JD Edwards EnterpriseOne HTML Server is installed in an instance of the application server that you defined when you installed the Web Server (for example, AS_JS_81). Complete this task to stop the server.

To Stop the HTML Server:

	
Start the Server Manager console.


	
Select the Server and Instance you want to stop.


	
Select the Stop button.









5.3 Accessing the HTML Server

You can access the HTML Server from any web browser connected to your network.

To access the HTML Server:

	
Open the JD Edwards HTML client by opening a browser and entering this URL:

http://<web_server_name>:<port_number>/jde/owhtml or

http://<web_server_name>:<port_number>/jde/E1Menu.maf

For example:

http://jdewebs1.myserver.com:81/jde/owhtml or

http://jdewebs1.myserver.com:81/jde/E1Menu.maf









5.4 Generating Serialized Objects for the HTML Server

Starting with application release 8.12, JD Edwards EnterpriseOne specs are delivered in XML format, which allows for on-demand generation of serialized Java objects from these XML specs. Objects are now automatically generated when the first user accesses an application, and the only objects not automatically generated are FDA-created portlets.

eGenerator can still be used to manually generate serialized objects. eGenerator is the only method for generating FDA-created portlets, so it is required if you installed a Portal and created portlets in the FDA application.

To install the eGenerator and manually generate serialized objects, refer to Appendix A, "Generating JD Edwards EnterpriseOne Serialized Objects".






5.5 Configuring the HTML Server for Non-Western European Languages

If you are setting up the HTML Server to run Non-Western European Languages, complete this task to ensure that the Application Server is properly configured for Unicode.

To configure the HTML Server for Non-Western European Languages:

	
Open the WebSphere Administrative Console, and select the Application Server for the JD Edwards HTML Server.


	
Using Server Manager, verify this code page parameter and setting:

codePage=1252









5.6 Enabling the Browser Side Debugging Feature on the Web Client

In past releases, a user working on a form in the web client could press the Ctrl+D keys to display GUI elements at the bottom of the page that are used for browser side debugging. Starting with release 8.96, this feature is disabled in the default mode, and the web client no longer displays this debugging feature when Ctrl+D is pressed. To enable this feature for developers and support personnel, the system administrator must modify the JDEDTA.js file as described in this task.

To enable the browser side debugging feature:

	
On the HTML Server, navigate to the webclient.war/js/ directory, and open the JDEDTA.js file in a text editor.


	
Search for the following line:

var allowDebug=false;

and change the value to true.


	
Save the file.

You do not need to restart the server to activate the change.


	
Open Internet Explorer, and press the Refresh button to reload the page.

This action refreshes the .js files cached in the browser to activate the Ctrl-D feature.









5.7 Customizing the Disclaimer for the Sign-In Page

When web-based clients log on to JD Edwards EnterpriseOne, the sign-in page includes a default disclaimer that is included in a file shipped with the HTML Server software. This task describes how to modify this file to include your own disclaimer.

To specify an additional disclaimer for the sign-in page:

	
Open this file in a text editor:

<JAS_HOME>\webcontent\share\html4login.jsp

where <JAS_HOME> is the installation directory of the HTML Server.


	
Make a backup of this file.


	
Locate the following line and specify your disclaimer with the following element:

String companyDisclaimerHTML = "";

For example:

String companyDisclaimerHTML = "By signing in, you agree to the <a href=\"http://server/path-to/privacypolicy.html\">privacy policy</a>.";




	
Tip:

This element is Java code. Therefore, quotation marks must be preceded by a back-slash character, as shown above.








	
Save the file.

Your changes should take effect immediately. If not, restart the portal.









5.8 Setting Up Quick Links for Pervasive Device Support

JD Edwards EnterpriseOne offers support for Pervasive Devices. Developers can write custom applications for PocketPC 2003 devices using the EnterpriseOne toolset. However, JD Edwards EnterpriseOne menus are not supported on Pervasive Device clients, so a new XML file (PervasiveAppQuickLinks.xml) was added to the HTML Server that allows a system administrator define the list of applications that can be executed on the Pervasive Device client. This file can be edited to add, modify, or delete JD Edwards EnterpriseOne applications that are accessible to Pervasive Device clients. Each application listed in this file is defined by a quick-link tag that describes the application, form, and version of the object, and includes a description. A sample quick-link tag is shown below:


<quick-links>

<quick-link launchAction="launchForm"
                  appID="P0411"
                  formID="W0411G"
                  version="ZJDE0001"
                  description="3 G0411 - Standard Voucher Entry 
                  (P0411_W0411G_ZJDE0001)"/>

</quick-links>


Quick-link tags can include the following attributes:


	Attribute	Required?	Description
	launchAction	yes	Specifies the action that occurs when users click on the quick-link. Valid values are:
	
launchForm

Launch the form directly.


	
promptForValue

Request values for the processing options.


	
promptForVersion

Request which version of the form to open.





	appID	yes	Program number of the application. For UBE type objects, the AppID is the UBE name.
	appType	Required for promptForVersion action.	Type of application.
Valid values are:

	
APP


	
UBE





	formID	Required for launchForm and promptForValue actions. Also required with the appType attribute.	Number of the specific form within the application.
	version	No	Version number of the form.
	description	Yes	Description of the form. This description appears in the list displayed on the Pervasive Device client.






To edit the PervasiveAppQuickLinks.xml file 

	
On the HTML Server, navigate to this directory: <JAS_Home>/installedApps/<node_name>/EA_JS_81.ear/webclient.war/classes.

Open the PervasiveAppQuickLinks.xml file in a text editor.


	
Add quick-link tags for each of the JD Edwards EnterpriseOne applications you want to make accessible to Pervasive Devices.

You can also delete or modify existing tags to remove or change the forms that Pervasive Device clients can access. When clients access JD Edwards EnterpriseOne from a Pervasive Device, the forms are listed as links in the same order they appear in the PervasiveAppQuickLinks.xml file.




Save and exit the file.

Below is an example of the PervasiveAppQuickLinks.xml file:


<?xml version="1.0" encoding="UTF-8" ?> 
<quick-links>
  <quick-link launchAction="launchForm" appID="P0411" formID="W0411G" 
version="ZJDE0001" description="3 G0411 - Standard Voucher Entry 
(P0411_W0411G_ZJDE0001)" /> 
  <quick-link launchAction="launchForm" appID="P01012" 
formID="W01012B" version="ZJDE0001" description="P01012_W01012B" /> 
  <quick-link launchAction="promptForValue" appID="P01012" 
formID="W01012B" version="ZJDE0001" mode="1" appType="APP" 
description="Prompt for Values(P01012_W01012B,ZJDE0001,1,APP)" /> 
  <quick-link launchAction="promptForValue" appID="P4210" 
formID="W4210E" description="Prompt for Values(P4210_W4210E)" /> 
  <quick-link launchAction="promptForVersion" appID="P01012" 
formID="W01012A" appType="APP" description="Prompt for 
Version(P01012_W01012A)" /> 
  <quick-link launchAction="promptForVersion" appID="R0006P" 
appType="UBE" description="Prompt for Version(R0006P)" /> 
  <quick-link launchAction="launchForm" appID="P98TREE" 
formID="W98TREEA" description="P98TREE_W98TREEA" /> 
  <quick-link launchAction="launchForm" appID="P98SYSGR" 
formID="W98SYSGRB" description="P98SYSGR_W98SYSGRB" /> 
  <quick-link launchAction="launchForm" appID="P98CTRL" 
formID="W98CTRLA" description="P98CTRL_W98CTRLA" /> 
  <quick-link launchAction="launchForm" appID="P98RUNPC" 
formID="W98RUNPCM" description="P98RUNPC_W98RUNPCM" /> 
  <quick-link launchAction="launchForm" appID="P98SYSFM" 
formID="W98SYSFMA" description="P98SYSFM_W98SYSFMA" /> 
  <quick-link launchAction="launchForm" appID="P98SYSFM" 
formID="W98SYSFMB" description="P98SYSFM_W98SYSFMB" /> 
  <quick-link launchAction="launchForm" appID="P98FRMFL" 
formID="W98FRMFLA" description="P98FRMFL_W98FRMFLA" /> 
  <quick-link launchAction="launchForm" appID="P98MEDIA" 
formID="W98MEDIAA" description="P98MEDIA_W98MEDIAA" /> 
  <quick-link launchAction="launchForm" appID="P90CB050" 
formID="W90CB050A" description="P90CB050_W90CB050A" /> 
  <quick-link launchAction="launchForm" appID="P55SFRU1" 
formID="W55SFRU1A" description="P55SFRU1_W55SFRU1A" /> 
  <quick-link launchAction="launchForm" appID="P99WIZ01" 
formID="W99WIZ01B" description="P99WIZ01_W99WIZ01B" /> 
  <quick-link launchAction="launchForm" appID="P99WIZ03" 
formID="W99WIZ03A" description="P99WIZ03_W99WIZ03A" /> 
  <quick-link launchAction="launchForm" appID="PMODAL" 
formID="WMODALA" description="PMODAL_WMODALA" /> 
  <quick-link launchAction="launchForm" appID="P42101" 
formID="W42101C" description="New Sales Order Application" /> 
  </quick-links>






5.9 Clearing File Attachments from the Browser Cache

In a typical environment, file attachments (such as Media Object attachments and JD Edwards EnterpriseOne reports) are automatically cached into the \Temporary Internet Files directory on web-based client machines when these attachments are opened from a browser. This situation allows copies of confidential documents, such as Media Objects, images, and web pages, to proliferate across workstations on which these objects are opened.

To prevent these objects from persisting in the internet cache, administrators should configure the browsers to automatically clear the cache when the client closes the browser. This protection is particularly important in a kiosk environment. The procedure for clearing the cache depends on the type of browser. Refer to the relevant task below to secure the browser used in your system.

In addition to securing the browser cache, Media Object Security was added in 8.96 to ensure that media objects can be secured within the application. For more information on this topic, see "Managing Media Object Security" in the JD Edwards EnterpriseOne Tools Security Administration Guide.

This section describes these tasks:

	
Securing Internet Explorer


	
Securing Safari


	
Securing Mozilla Firefox






5.9.1 Securing Internet Explorer

Complete this task to automatically clear the cache in Internet Explorer.

	
In Internet Explorer, select Tools, Internet Options from the drop down menu.


	
Click the Advanced tab.


	
In the "Settings" box, scroll down to the section labeled "Security," and select the check box next to Empty Temporary Internet Files folder when browser is closed."


	
Click OK to save the change.

This option does not delete cookies, but will clear your cache of other files when you close the browser.




	
Tip:

Access the following web page for more details:
http://www.microsoft.com/windows/ie/using/howto/customizing/clearcache.mspx

















5.9.2 Securing Safari

Activate the Private Browsing feature of Safaris to secure the browser. When activated, no web addresses, personal information, or pages are saved or cached on the browser, and no trace of any activity is recorded.






5.9.3 Securing Mozilla Firefox

Activate the Clear Private Data tool to secure Firefox. This tool allows you to delete all personal data, including browsing history, cookies, Web form entries and passwords with a single click. Mozilla Firefox can also be configured to automatically clear this information when you close the browser.










6 Understanding EnterpriseOne HTML Server Package Discovery

This chapter contains the following topics:

	
Section 6.1, "Overview of EnterpriseOne HTML Server Package Discovery"


	
Section 6.2, "Impacts to End Users"


	
Section 6.3, "Understanding the Manifest"






6.1 Overview of EnterpriseOne HTML Server Package Discovery

Starting with JD Edwards EnterpriseOne release 8.12, EnterpriseOne specs are delivered in XML format. The new format enables the specs to be stored in database tables instead of the TAM files, and is called Shared Object Configuration. In this configuration, both Enterprise Servers and HTML Servers access the same database for the same set of specs.

Before release 8.12, whenever a new package was deployed to the Enterprise Server, you had to install the package on a development client and manually generate serialized objects for the HTML Server. With release 8.12, however, manual generation is now optional. Instead, the JD Edwards EnterpriseOne now automatically generates objects on the fly if they do not exist in the serialized object tables.

When you deploy a package to the Enterprise Server, the HTML Server automatically discovers the new package and purges all serialized records impacted by the package. If a full package is deployed, the HTML Server deletes all serialized object records. If an update package is deployed, the HTML Server deletes only those records that are included in the update package. It also removes the impacted objects from in-memory cache. After the package deployment is complete, when a user accesses an EnterpriseOne object, this object is generated on the fly using the new specs delivered in the package.

To ensure the integrity of the specs, the HTML Server must be configured so that:

	
Each EnterpriseOne JAS instance includes only one path code and one package within the path code.


	
All users accessing a JD Edwards EnterpriseOne HTML Server instance access only one package.


	
Serialized object databases are not shared among multiple EnterpriseOne JAS instances, unless all these instances run on the same path code and same package.









6.2 Impacts to End Users

During package deployment, the HTML Server stops responding to user requests until the package is deployed and serialized objects are purged. During this process, user will not able to log in. Users that are already logged in prior to the package deployment will not be able to launch new forms until the package deployment is complete.






6.3 Understanding the Manifest

Each package now contains a package manifest. The manifest is a record in a new table that is created every time a package is built. The package manifest contains a date/time stamp for the package build and information about the package content. For update packages, it also contains a list of objects included in the package.

Each serialized object table now contains a serialized object manifest. This manifest indicates what specs are used to generate the serialized objects. For example, the manifest includes the name of the package used to generate the serialized objects. To ensure the integrity of the system, all serialized objects are generated from the same package.

When the HTML Server detects a package deployment, it compares the package manifest with the serialized object manifest. If a new package is deployed, the package manifest will be different than the serialized object manifest. The HTML Server purges the serialized objects table of objects listed in the package manifest. The HTML Server then updates the serialized object manifest so it is consistent with the package manifest. This entire process is automatic and does not need administrator involvement.

If you decide to generate objects manually using the eGenerator, you must generate the manifest manually for the discovery process to work. For instructions on how to generate the manifest, see Generating the Serialized Object Manifest in Generating JD Edwards EnterpriseOne Serialized Objects.








A Generating JD Edwards EnterpriseOne Serialized Objects

This appendix describes the tasks to install eGenerator and generate JD Edwards EnterpriseOne JAS objects from a set of JD Edwards EnterpriseOne objects. It contains the following topics:

	
Section A.1, "Generating JD Edwards EnterpriseOne Serialized Objects Overview"


	
Section A.2, "Installing eGenerator"


	
Section A.3, "Working with the eGenerator"


	
Section A.4, "Configuring eGenerator"


	
Section A.5, "Generating the Serialized Object Manifest"


	
Section A.6, "Generating All Standard Serialized Objects"


	
Section A.7, "Generating a List of Objects (Bulk Generation)"


	
Section A.8, "Verifying the Generation Process"


	
Section A.9, "Generating Other Selected Objects"






A.1 Generating JD Edwards EnterpriseOne Serialized Objects Overview

The first step is determine which JDK to use:

	
HTML Server with WebSphere Application Server 7.0

You must use JDK version 1.6 on your eGenerator script.


	
HTML Server with WebSphere Application Server 8.5.x

You must use JDK version 1.7 on your eGenerator script.




	
Note:

If you are running eGenerator on your Development Client for WebSphere 8.5.x, you will need JDK 1.6 32-bit for your Development Client and JDK 1.7 for the eGenerator.










Starting with application release 8.12, JD Edwards EnterpriseOne specs are delivered in XML format, which allows for on-demand generation of serialized objects from these XML specs. Objects are now automatically generated when the first user accesses an application.

eGenerator can still be used to manually generate serialized objects. It is the only method for generating FDA-created portlets, so is required if you installed a JD Edwards EnterpriseOne Portal. eGenerator is also an optional path for generating any set of objects, including a complete set of objects.

The eGenerator allows manual control over the process that turns JD Edwards EnterpriseOne specifications into Java code, which enables you to access JD Edwards EnterpriseOne applications in HTML. The JD Edwards EnterpriseOne forms and applications that you generate, either manually from eGenerator, or automatically using on-demand generation, are serialized Java objects. JD Edwards EnterpriseOne stores these objects in a database (in serialized object tables F989998 & F989999), and retrieves them at runtime.

eGenerator requires a specific machine configuration. While it is possible to configure a web server as the generation machine for release 8.12, you should dedicate a separate generation machine for this process. The configuration of this machine depends on the release of JD Edwards EnterpriseOne you installed.

If you upgraded to JD Edwards EnterpriseOne from a previous release and customized your JD Edwards EnterpriseOne objects, you should first test your custom modifications, then generate serialized JAS objects from the upgraded path code.






A.2 Installing eGenerator

This topic discusses the tasks you follow to install the eGenerator:

	
Section A.2.1, "Prerequisites"


	
Section A.2.2, "Setting the Default Storage Parameter (SQL Server only)"


	
Section A.2.3, "Preparing JD Edwards EnterpriseOne for Serialized Objects"


	
Section A.3.3, "Bypass the Web Server and Generate Serialized Objects Directly to the Serialized Object Tables"






A.2.1 Prerequisites

Before you install the eGenerator, verify that the tasks below are completed for your version of JD Edwards EnterpriseOne:

	
Complete the task: "Copying the JDBC Drivers and the tnsnames.ora file to the Deployment Server" in the JD Edwards EnterpriseOne Development Client Installation Guide.




	
Caution:

This task must be completed by a JD Edwards EnterpriseOne system administrator before you complete any of the tasks below.








	
Install the Web Development Client to set up eGenerator.

If the Web Development Client installs successfully, eGenerator is automatically configured to run without modifying any of the files used in the generation process.

Refer to the JD Edwards EnterpriseOne Development Client Installation Guide.


	
Complete this task if you are using IBM DB2 on the Enterprise Server.

On the Generation machine, open the db2cli.ini file and comment out or remove the LobCachSize parameters under database aliases associated with JD Edwards EnterpriseOne. This file is typically located under DB_HOME\SQLLIB\.









A.2.2 Setting the Default Storage Parameter (SQL Server only)

For SQL Servers databases, the default storage parameter on your JD Edwards EnterpriseOne database might not enable enough space to transfer all the standard JD Edwards EnterpriseOne Java objects. To avoid this problem, complete the task below:

To set the default storage parameter:

	
Open the SQL Server database and set your database Maximum File Size parameter to "Unrestricted filegrowth."

Complete this step for each database (for example, PY900) to which you are installing the Java objects.









A.2.3 Preparing JD Edwards EnterpriseOne for Serialized Objects

Before you generate serialized Java objects in JD Edwards EnterpriseOne, complete this task to link to the JD Edwards EnterpriseOne serialized object tables on the Java generation machine.

Complete this task only if you want to generate serialized objects on a different location other than the datasouce listed in the Object Configuration Manager (OCM). If you choose this option, you can use this procedure to edit the JD Edwards EnterpriseOne Spec database.

	
Sign on to Server Manager Console.


	
Open the database configuration of the HTML instance.

[image: Surrounding text describes jdbj_spec_datasource.gif.]

	
On JDBj Spec Datasource, enter the Spec Datasource information.


	
Save the configuration and restart the HTML instance.











A.3 Working with the eGenerator

This section describes these topics:

	
Section A.3.1, "Running the eGenerator Diagnostic Tool"


	
Section A.3.2, "Generate Using the Web Server"


	
Section A.3.3, "Bypass the Web Server and Generate Serialized Objects Directly to the Serialized Object Tables"




Each method of generation has a specific way to log into eGenerator. Select the task that corresponds to the way you want to generate objects.



A.3.1 Running the eGenerator Diagnostic Tool

eGenerator now includes an application that is automatically launched every time eGenerator is started. This application is a diagnostic tool that checks the configuration of eGenerator and reports incorrect settings. The diagnostic tool categorizes errors into two types: fatal and non-fatal. If a fatal error is detected, the application displays an error message and does not enable eGenerator to launch. If a non-fatal error is detected, the application displays an error message but enables you to continue with the Generation process.




	
Note:

The auto diagnostic tool can be suppressed by launching gen.bat with the -nodiag parameter.







The auto diagnostic tool performs these operations for general use:

The auto diagnostic tool performs these operations for general use for Direct Generation:


	Operation	Fatal Error
	Generates a Web Code Level Object, which is used by JAS at startup to determine if its code matches the generated objects.	X
	Checks the location of the jas.ini file and validates these key parameters in the file.	

	Checks the location of the location of the jas logs.	








For JAS Generation only


	Operation	Fatal Error
	Verifies that the Tools Release of the JAS code on the generation machine matches the Tools Release of the JAS code on the HTML Server (fatal error).	X










A.3.2 Generate Using the Web Server

Complete this task to generate objects using the web server.

	
On your generation machine, select your configuration below, navigate to this directory:

x:\<release>\JAS




	
Note:

If you do not want to run the diagnostic program, include the parameter -nodiag in the command statement when you run launchGen.bat. See the section, Running the eGenerator Diagnostic Tool, for more information about the autodiagnostic tool.








	
From the above directory, run the launchGen.bat file.

[image: Surrounding text describes gen_new002.gif.]

	
On Generator, complete this field:

	
JAS Server Name

Enter machine name:port, where machine name is the name of your web server and port is the port number for the EnterpriseOne instance.





	
Click the Connect button.


	
Enter the login information for JD Edwards EnterpriseOne. After the connection is successful, the eGenerator is properly configured to generate the objects through the Web Server you specified.


	
Select where the specs exist for generation. You can generate specs from a specific set of Central Objects or a particular path code. By default, Default Spec Files will be used. Default Spec Files reside on the local machine.

Choose one of the following options:

	
To generate specs from a particular set of Central Objects:

Click the Central Objects radio button, and enter the Path Code where the specs are stored.

[image: Surrounding text describes gen_new003.gif.]

	
To generate specs from a specific package:

Click the Package radio button, and enter the name of the Package and the DataSource where the specs are stored.

[image: Surrounding text describes gen_new004.gif.]




	
Click Connect.

The system connects to the Web server that you indicated. A message appears on the status bar when login is complete.

Once you have logged in to a Web server, skip the following task and refer to the sections below it for information on how to generate objects.









A.3.3 Bypass the Web Server and Generate Serialized Objects Directly to the Serialized Object Tables

Select direct generation by clicking the Direct Generation radio button in the Connection section on the eGenerator application.

In this mode, the generator initializes a "mini" HTML Web Server instance on the generation machine. During generation, the generator will by-pass the actual HTMl Web Server and store the objects directly to the serialized object tables. After you complete this task, you can set up the HTML Server to read from the pre-populated serialized object tables.

Advantages:

	
Can generate objects before setting up the HTML Server.


	
Faster for all forms of generation.


	
Easier to maintain.




Disadvantages: You must configure the generation machine.

Complete this task to generate objects directly to a database.

	
Run the launchGen.bat file.




	
Note:

If you do not want to run the diagnostic program, include the parameter -nodiag in the command statement when you run launchGen.bat. See the section, Section A.3.1, "Running the eGenerator Diagnostic Tool", for more information about the autodiagnostic tool.







[image: Surrounding text describes gen_new001.gif.]

	
On Generator, click the Direct Generation radio button.

In Direct Generation Mode the eGenerator locates the serialized object database by looking for the database server in the server= setting of the JDBj-SPEC DATA SOURCE section of the jdbj.ini file located on the generation machine.


	
Click the Connect button and enter the login information for JD Edwards EnterpriseOne.

The system bypasses the Web server and connects directly to the database specified in the jdbj.ini file.











A.4 Configuring eGenerator

eGenerator includes a number of options you can set up for your particular environment. The configuration process consists of these tasks:

	
Setting eGenerator Options


	
Choosing Languages


	
Configuring the genapp.ini File






A.4.1 Setting eGenerator Options

Before generating objects, you can define a variety of parameters that affect how the eGenerator functions.

	
From the pull-down menu, select OptionsAdvanced Settings.


	
On Advanced Settings, select the options appropriate for your generation requirements

[image: Surrounding text describes gen_new005.gif.]

	
Logging

Specify whether to log the generation process by clicking the check boxes next to the Status and Error logs. You can also enter the location of the log files. Logging is crucial for troubleshooting problems with the generation process.


	
Generation Modes

Specify if the generation of All Objects will be done in parallel mode or sequential mode by checking the appropriate radio button.

For more information on Generation Modes, see Generation Modes.


	
User Option

You can generate a public version of the applications or a personal version by choosing the relevant option. Personal versions are only available to the person who created the versions, and are only intended for developers.


	
Protocol Option

Starting with Tool Release 9.1.4, you can choose the HTTPS Protocol connection to the Web Server. You must include the HTML server certificate location in the gen.bat file. The location is set by the -Djavax.net.ssl.trustStore= parameter (bolded) as shown in this example:


%JAVA_PGM% -Xss1m -Xms128m -Xmx512m -Ddefault_path=%INI_DIR% -Djavax.net.ssl.trustStore=Z:/E910/e1keystore -classpath %GEN_CLASSPATH% com.jdedwards.runtime.generator.Generator %1


%JAVA_PGM% -Xss1m -Xms128m -Xmx512m -Ddefault_path=%INI_DIR% -Djavax.net.ssl.trustStore=Z:/E910/e1keystore -classpath %GEN_CLASSPATH% com.jdedwards.runtime.generator.Generator %1









A.4.1.1 Generation Modes

The eGenerator has these modes for generating web objects:

	
Sequential Generation


	
Parallel Generation






A.4.1.1.1 Sequential Generation

In this mode the web objects are generated one after the other when you select the Generate-All Objects option. You can set this mode by clicking OptionsAdvanced Settings, then clicking Sequential Generation.

Advantages:

	
Most stable mode of generation.


	
Requires the least system resources, e.g. memory.


	
Safe to use during a JITI (Just in Time Install) process.




Disadvantage: The generation process can take longer.






A.4.1.1.2 Parallel Generation

This is the default mode of generation. You can turn off this mode of generation by clicking Advanced Settings, then clicking Sequential Generation.

In this mode of generation the web objects are generated concurrently when you select the Generate-All Objects option

Advantage: Faster than Sequential Generation, especially with multi-processor workstations and fast database connections.

Disadvantages:

	
Cannot be used when the user doesn't have the full set of spec files, because JITI might occur.


	
If a JITI occurs during parallel generation, the spec files can get corrupted.













A.4.2 Choosing Languages

You can generate applications and reports in the language you desire by selecting any of the supported languages on the eGenerator application.




	
Note:

You must install the Language CD for each language you want to use.







To select languages 

	
On eGenerator, select OptionsLanguages from the pull-down menu.

[image: Surrounding text describes generator_002.gif.]

	
Click the check box next to each of the languages you want to use.


	
Click OK.









A.4.3 Configuring the genapp.ini File

The genapp.ini file contains the list of applications that you want generated in a mode other than the default mode, which is mode 1. In the genapp.ini file, you can list applications you want generated in one of the other modes: Mode 2 or Mode 3.

Do not modify this file unless you created custom applications using Mode 2 or Mode 3.








A.5 Generating the Serialized Object Manifest

The section describes how to generate the manifest for the set of objects in the serialized object tables. For an overview of the serialized object manifest and a description of the package discovery process, refer to Understanding EnterpriseOne HTML Server Package Discovery.

To generate serialized object manifests 

	
From the pull-down menu, select GenerateManifest.

[image: Surrounding text describes manifest_info.gif.]

	
Click Create Manifest.

[image: Surrounding text describes manifest_creation_warning.gif.]

	
Click Yes.

The program creates the manifest and closes the window.


	
To view the manifest that was created, from the pull down menu, select GenerateManifest.

[image: Surrounding text describes manifest_creation_xml.gif.]

The Manifest Info section displays the name of the package, the build date, and the deployment date. This manifest shows that no update packages were deployed.

The Manifest Audit Info field contains information about the user and the machine that created the manifest.









A.6 Generating All Standard Serialized Objects

eGenerator can generate a complete set of Java Serialized Objects from JD Edwards EnterpriseOne objects. These serialized objects enable you access to all JD Edwards EnterpriseOne objects when you run your web server. If, however, you only want to generate a partial set of objects, skip this task and complete the relevant task in the section: Section A.9, "Generating Other Selected Objects".

Complete this task to generate a complete set of JD Edwards EnterpriseOne objects.

	
From the pull-down menu, select File > Core Objects.

For more information on generating core objects, see Section A.9.1, "Generating Core Objects".


	
If the core objects generate successfully, from the pull-down menu, select Generate > All Objects.

[image: Surrounding text describes generator_all_objs.gif.]

	
On Generate All Objects, check all the objects listed.


	
Click the Start button.

eGenerator checks the database connection before it attempts to generate objects.

If it cannot connect to the database, eGenerator displays this screen:

[image: Surrounding text describes gen_check_connection.gif.]

	
If this screen displays, click the Stop button and verify the connection to the database.


	
If the last Generate-All session did not conclude successfully, eGenerator displays a screen with the details of the failed generation.

Select one of these options:

	
To resume the previous generation process, click RESUME OLD SESSION. You should select this option, which restarts the previous process from the point of failure. Once the previous process completes, you can repeat this task to generate the new set of objects.


	
To cancel the previous generation process and generate the new objects, click CREATE NEW SESSION.

Select this option if you are currently generating a complete new set of all object types.




In either case, an object set starts generating. The progress of object generation is displayed on the screen: the blue progress bar indicates the progress of the generation process, and the green progress bar indicates the progress of objects inserted into the database.

If the database insertion of objects is not complete when the generation is done, the eGenerator displays the number of objects remaining in the queue.

Once all the objects are inserted into the database, the program displays a message that the "Generation completed successfully."









A.7 Generating a List of Objects (Bulk Generation)

If you are running EnterpriseOne release 812, the JAS servers generates objects on demand. To reduce the performance impact of on-demand generation, you can manually generate a list of the most frequently used applications from a list defined in a text file, and let other applications or reports to be generated on demand.

A sample text file named BulkGen.txt is included with the HTML Server or Web Development Client under the WEB-INF directory. This file contains sample entries in the format that can be read by the eGenerator. Modify this file to include just the large, frequently used applications.

To run the bulk generation file 

	
Run launchGen.bat.


	
On eGenerator, complete this field:

	
Bulk Generation File: Enter the name of the file, or click Select File, and select the Bulk Generation File.




It may take some time for the system to connect to the file.


	
Select a Connection option (either Direct Generation or JAS Server).


	
Select Default Spec Files.


	
Click Connect.


	
Log on to JD Edwards EnterpriseOne and click OK.


	
From the pull-down menu at the top of the screen, select FileBulk Generation.


	
Click Start.

eGenerator will generate all the objects listed in the file you selected. When the process is complete, eGenerator displays a message: Generation Completed Successfully.







	
Tip:

The update package build generates a GeneratorList.txt file in the work directory of the package. The GeneratorList.txt file is a well formed bulk generation file that lists the objects included in the update package. You can use this file for Bulk Generation after deploying the update package.












A.8 Verifying the Generation Process

Complete these tasks to verify the generation is successful:

	
Checking Log Files


	
Checking Database Acknowledgements






A.8.1 Checking Log Files

eGenerator enables you to automatically display the Status Log and Error Log files by selecting these options from a menu.

To display the Status Log 

	
On eGenerator, select LogsStatus Log from the pull-down menu.




To display the Error Log 

	
On Generator, select LogsError Log from the pull-down menu.









A.8.2 Checking Database Acknowledgements

The status log records whether an object is successfully inserted in the database. This enables the user to monitor the generation process and verify that objects are successfully generated.

These acknowledgments will not be printed for data dictionary Items or Data Structures, however, because they are too numerous to be printed on the command line screen.

Below is an example of the output:


Generating application P01012 ...
-->Database Ack:ER_P01012_W01012D successfully inserted into database
-->Database Ack:P01012_HTML_W01012D successfully inserted into database
-->Database Ack:ER_P01012_W01012B successfully inserted into database
-->Database Ack:P01012_HTML_W01012B successfully inserted into database
-->Database Ack:ER_P01012_W01012A successfully inserted into database
-->Database Ack:P01012_HTML_W01012A successfully inserted into database App
generation finished Generating 2 NERs -->Database Ack: ER_P01012_W01012C
successfully inserted into database -->Database Ack: P01012_HTML_W01012C
successfully inserted into database -->Database Ack: NER_PlugAndPlay_P0101
successfully inserted into database NER generation finished Generating 1 PO
Data Structure Items PO Data Structure generation finished Generating 2
Business Views Business View generation finished Generating 5 Tables Table
generation finished Generating 294 Data Dictionary Items Data Dictionary
generation finished Generating 30 Data Structure Items Data Structure
generation finished -->Database Ack:NER_UpdateChangedGeoCode successfully
inserted into database -->Database Ack: PODATAP01012 successfully inserted
into database -->Database Ack:VIEW_V0101E successfully inserted into
database -->Database Ack: TABLE_F0101 successfully inserted into database
-->Database Ack: TABLE_F0111 successfully inserted into database
-->Database Ack: TABLE_F0116 successfully inserted into database
-->Database Ack: TABLE_F03012successfully inserted into database
-->Database Ack: TABLE_F0401 successfully inserted into database








A.9 Generating Other Selected Objects

When you deploy an update package of JD Edwards EnterpriseOne objects, you can either depend on the on-demand feature of the HTML Server to generate serialized objects, or you can manually generate selected objects using eGenerator. eGenerator includes several methods of generating a partial set of serialized objects. All but one method, "Generating objects using the Bulk Generation File," are performed by selecting options from the eGenerator screen. The Bulk Generation file enables you to type selected objects directly into a text file and run this file in eGenerator.

Complete one of these tasks to generate a partial set of serialized objects.

	
Generating Core Objects.


	
Generating Applications.


	
Generating Forms.


	
Generating Reports.


	
Generating NERs.


	
Generating Data Dictionary Items.


	
Generating Tables.


	
Generating Business Views.


	
Generating Data Structures.






A.9.1 Generating Core Objects

The core objects are the foundation objects required by other JD Edwards EnterpriseOne components. Generating these objects enables the Java server to run Task Explorer and the Portal without installing specific applications.

To generate core objects, on eGenerator, select FileCoreObjects from the pull-down menu.

eGenerator begins generating the core objects and their dependent Data Dictionary Items.

The eGenerator displays the status of the generation once the process is complete.






A.9.2 Generating Applications

Complete one of these tasks to generate one or more applications:

	
From the pull-down menu, select Generate -> Applications.


	
From the pull-down menu, select Generate ->Application.


	
From the pull-down menu, select Generate -> Application.




To generate an application:


	
From the pull-down menu, select Generate -> Applications.

[image: Surrounding text describes generator_gen_apps_by.gif.]

	
Select Application Name, and enter the program number of the application (for example, P01012).


	
Click Start.

The Generator generates all forms contained in the application and all dependent objects used by the application.


	
Check the Status Log for status of generation.




To generate applications by system code


	
From the pull-down menu, select Generate ->Application.


	
Select Generate by System Code, and type the number of the System Code in the field to the right.

[image: Surrounding text describes generator_gen_apps_by.gif.]

	
Click Start.

eGenerator fetches all the applications under that system code.


	
Confirm the applications were generated by checking the status and error logs.


	
Use this SQL command to verify the applications reside in the database:

SQL> select wboid from f989999 where wboid like P%W%;




You can generate applications by modes 1, 2 or 3. These modes determine the look and feel of the applications. For more information on Generation Modes, see the section "Generating Options" in Designing JD Edwards EnterpriseOne Web Applications.

To Generate applications by mode


	
From the pull-down menu, select Generate -> Application.


	
Select a mode.

[image: Surrounding text describes generator_apps_mode3.gif.]

	
Click Application Name, and enter the name of an application (for example, P01012).


	
Click Start.









A.9.3 Generating Forms

To generate a form 

	
From the pull-down menu, select GenerateApplications.


	
Enter the form name in the Form Name field, for example, P01012_W01012A.


	
Click Start.

If the form name is invalid, this error message appears:

[image: Surrounding text describes gen_form_invalid.gif.]

If the application name is invalid, this error message appears:

[image: Surrounding text describes gen_form_invalid_name.gif.]

	
Check the status log for the generation status.









A.9.4 Generating Reports

Complete one of these tasks to generate one or more reports:

	
From the pull-down menu, select Generate -> Reports.


	
From the pull-down menu, select Generate -> Reports.


	
From the pull-down menu, select Generate ->Reports.




To generate a report


	
From the pull-down menu, select Generate -> Reports.


	
Enter the name of a report, (for example, R0006P).


	
Click Start.


	
Check the status log for the generation status.

The Generator generates all versions of the report and their corresponding data selection, data sequencing, and Print Information Objects.


	
Confirm the presence of the objects by checking the Status logs, or use this query to check the database:

SQL> select wboid from f989999 where wboid like %<report_name>%;




To generate a report version


	
From the pull-down menu, select Generate -> Reports.


	
Enter a Report Name and Report Version, for example, R0006P, and XJDE0001.

[image: Surrounding text describes generate_reports.gif.]

	
Click Start.

The Generator generates the version and any dependent objects.


	
Check the status log for the generation status.




To generate reports by system code


	
From the pull-down menu, select Generate ->Reports.


	
Select Generate by System Code, and enter a number for the code.


	
Click Start.

[image: Surrounding text describes generate_reports_by.gif.]

eGenerator fetches all the reports under that system code.


	
Check the status and error logs to confirm that all the reports for that system code were generated.









A.9.5 Generating NERs

To generate NERs 

	
From the pull-down menu, select GenerateNERs.


	
Enter the name of an NER, for example, GetObjectDesc.




	
Note:

NERs are case sensitive.







[image: Surrounding text describes generate_ners.gif.]

	
Click Start.


	
Check the status log for the generation status.


	
Use this SQL command to verify that the objects reside in the database.

SQL> select wboid from f989999 where wboid like <NER_ name>









A.9.6 Generating Data Dictionary Items

To generate Data Dictionary items 

	
From the pull-down menu, select Generate -> Data Dictionary.


	
Generate any data dictionary item, for example, OBNM.

[image: Surrounding text describes generate_dd.gif.]

	
Check the status log for the generation status.


	
Use this SQL command to verify that the objects reside in the database.

SQL> select wboid from f989999 where wboid like 'DICT_<dd_name>';









A.9.7 Generating Tables

To generate tables 

	
From the pull-down menu, select Generate -> Tables.


	
Enter a table number, for example, F9860.

[image: Surrounding text describes generate_table.gif.]

	
Click Start.

eGenerator generates the table and all data dictionary items used by the table.


	
Check the status log for the generation status.









A.9.8 Generating Business Views

To generate business views 

	
From the pull-down menu, select Generate -> Business Views.


	
Enter the name of a business view, for example, e.g. V9001B.


	
Click Start.

eGenerator generates the View and all associated tables and data dictionary items.


	
Check the status log for the generation status.

[image: Surrounding text describes generator_bvs.gif.]








A.9.9 Generating Data Structures

To generate data structures 

	
From the pull-down menu, select Generate -> Data Structures.


	
Enter the name of a data structure, for example, D9800150C.

[image: Surrounding text describes generate_ds.gif.]

	
Click Start.

eGenerator generates the data structure.


	
Check the status log for the generation status.


	
Use this SQL command to verify that the objects reside in the database:

SQL> select wboid from f989999 where wboid like 'DSTR_ <datastructure_name>'













B Configuring Secure Socket Layer with the HTML Server

The chapter describes how to configure Secure Socket Layer (SSL) with the HTML Server, and includes the following tasks:

	
Configuring SSL on the IBM HTTP Server


	
Configuring SSL on IBM WebSphere






B.1 Configuring SSL on the IBM HTTP Server

SSL requires a Signed Personal Certificate. You can either request a CA-Signed Personal Certificate directly from IBM, or you can generate a Self-Signed Certificate yourself. This task describes how to generate and use a Self-Signed Certificate. For production environments, we recommend you request one from CA. For instructions to request a CA-Signed Personal Certificate, refer to the IBM Info Center.

	
Create a folder named keys in the HTTP Server installation directory.


	
Start the Key Management Utility by navigating the following path:

Start > Programs > IBM HTTP Server > Start Key Management Utility

Alternately you can use a script found in this directory

Z:\IBM\HTTPServer\bin


	
In the IBM Key Management utility, create a Key Database File by navigating Key Database File > New.

[image: This image is described in surrounding text.]

	
At the prompt, enter the following information:

	
Key Database Type = CMS

Only CMS is supported with the IBM HTTP Server.


	
File Name = serverkey.kdb


	
Location = x:\IBM\HTTPServer\keys

where x: is the drive on which you installed the IBM HTTP Server.





	
Enter the password (for example, "serverkey") and select the option stash the password file.


	
Click the OK button.


	
From the drop down box, select Personal Certificates.


	
Click New Self-Signed.


	
Enter following information on the screen that appears:

	
Key Label= Enter any label (for example, server_cert)


	
Version= X509V3


	
Key Size = 1024


	
Common Name = Fully Qualified Server Name (for example, denicint2.mlab.jdedwards.com)


	
Organization = your organization name (for example, Oracle).


	
Country or region = US


	
Validity Period = 365 days




A sample screen shot is provided below:

[image: This image is described in surrounding text.]

	
On Create New Self-Signed Certificate, after the fields are complete click the OK button.

The program displays your certificate in the list.


	
Delete all the other certificates.


	
Open the httpd.conf file in a text editor, and add the following virtual host definition.




	
Note:

The text in the httpd.conf is case sensitive; type the host definition exactly as shown.







If you have already configured a port on the HTTP Server (for example, port 91), the file will include an Alias. Use the same alias under your Virtual Host definition as described here.


# Example SSL configuration which supports SSLv3 and TLSv1
# To enable this support:
#   1) Create a key database with ikeyman
#   2) Update the KeyFile directive below to point to that key database
#   3) Uncomment the directives up through the end of the example
#      Note: The IPv6 Listen directive must only be uncommented if
#      IPv6 networking is enabled.
#
# uncomment below line to enable ssl
LoadModule ibm_ssl_module modules/mod_ibm_ssl.so
<IfModule mod_ibm_ssl.c>
Listen 0.0.0.0:443
# IPv6 support:
# Listen [::]:443
<VirtualHost *:443>
Alias /jde "Z:\IBM\WebSphere\AppServer\profiles\AppSrv02\installedApps\denicint2Node01Cell\EA_JS_91.ear\webclient.war"
SSLEnable
SSLProtocolDisable SSLv2
</VirtualHost>
<Directory "Z:\IBM\WebSphere\AppServer\profiles\AppSrv02\installedApps\denicint2Node01Cell\EA_JS_91.ear\webclient.war\WEB_INF">
Order Deny,Allow
Deny from All
</Directory>
<Directory "Z:\IBM\WebSphere\AppServer\profiles\AppSrv02\installedApps\denicint2Node01Cell\EA_JS_91.ear\webclient.war">
Order Deny,Allow
Allow from All
</Directory>
</IfModule>
KeyFile Z:\IBM/HTTPServer\keys\WebServerKeys.kdb
SSLDisable
# End of example SSL configuration


This definition is taken from the httpd.conf file itself. It is advisable to backup the httpd.conf file before making changes to the file. After the IBM HTTP Server SSL Configuration, test the setup by typing in the URL as below:

https://<machine_name>:443/

A sample screen shot of the expected result is as below:

[image: This image is described in surrounding text.]








B.2 Configuring SSL on IBM WebSphere

	
Log on to your WebSphere Admin Console.


	
Navigate to EnvironmentVirtual Hosts.


	
Select your virtual host.

For example, if you initially installed your application on port 91, then the virtual host should be VH_EA_JS_91.


	
Under the virtual host, select Additional PropertiesHostAliases.


	
Under Host Aliases, click New.

A sample screen shot is provided below:

[image: This image is described in surrounding text.]

	
Create a new host alias using the fully qualified name of the server and a port number of 443.

	
Host: *


	
port: 443 (Default SSL Port)





	
Regenerate and propogate the HTTP Server plug-in file and restart your HTTP Server.


	
Restart the Application Server.

You should be able to login to the following URL:

https://fully_qualified_server_name/jde/E1Menu.maf




	
Note:

If SSL is activated, the system uses https instead of the http protocol.

















C Uninstalling WebSphere Fix Packs

These appendix describes these tasks:

	
Section C.1, "Uninstalling a WebSphere 8.5 Fix Pack"


	
Section C.2, "Uninstalling a WebSphere 7.0 Fix Pack"






C.1 Uninstalling a WebSphere 8.5 Fix Pack

To uninstall a WebSphere 7.0 fix pack:

	
Launch the Update Installer wizard.


	
Select the Uninstall option.

[image: This image is described in surrounding text.]

	
On Uninstall Packages, use the checkboxes to select the Installation Package that you want to uninstall


	
Click the Uninstall button.









C.2 Uninstalling a WebSphere 7.0 Fix Pack

To uninstall a WebSphere 7.0 fix pack:

	
Launch the Update Installer wizard.

[image: This image is described in surrounding text.]

	
On Product Selection, use the pulldown to select the directory path for the component that you wish to uninstall.

[image: This image is described in surrounding text.]

	
On Maintenance Operation Selection, choose the radio button for Uninstall maintenance package.

[image: This image is described in surrounding text.]

	
On the maintenance package to uninstall screen, select the radio button associated with an available package to uninstall and click Next.

Repeat the same process for other packages as necessary.











D Enabling Compression on IBM HTTP Server

You can set the mod_deflate directive within the httpd.conf file to enable the IBM HTTP Server to compress output files and log the compression ratios. mod_deflate is an Apache module in the httpd.conf file that compresses content sent from the web server to the client browser.

This appendix contains the following topics:

	
Section D.1, "Understanding Compression"


	
Section D.2, "Configuring the mod_deflate directive"






D.1 Understanding Compression

Regular text and most non-image content are well suited for compression. Text files can typically be compressed by 70% or more. Compression can save significant bandwidth and enable faster browser response times. The effect is negligible in most high speed LAN environments, but is quite noticeable for users on slow WAN connections.

Compression is not recommended for files that are already compressed. A partial list includes these types of files:

	
zip


	
PDF


	
exe


	
image files




Compressing these file types using mod_deflate can actually increase their size or corrupt the files.

There are 9 levels of compression available when using mod_deflate. The difference between the default level (6) and the maximum compression level (9) is minimal, and the cost in extra CPU time necessary to process the higher compression level is significant and ultimately not beneficial. For this reason, you should use the default compression level.






D.2 Configuring the mod_deflate directive

For specific instructions to configure the mod_deflate directive, access the Apache documentation on this web page, http://httpd.apache.org/docs/2.0/, and click on the link for http://httpd.apache.org/docs/2.0/mod/directives.html. Refer to this web page for instructions to configure each of the parameters discussed below. Also refer to the sample mod_deflate module at the end of this appendix.

To enable compression, open the httpd.conf file, and verify that the LoadModule deflate_module is uncommented (see the example below). You can configure mod_deflate to compress documents in one of two ways (both of which are specified in the httpd.conf file):

	
Explicit exclusion of files by extension

This method lists the file types that should NOT be compressed by the http server.


	
Explicit inclusion of files by MIME type.

This method lists file types that should always be compressed by the http server.





D.2.1 Logging Compression Results

The following three directives can be added to the httpd.conf file to enable the writing of compression statistics to a log file. These directives will record the bytes before compression (Input), the bytes after compression (Output), and calculate the compression ratio:


DeflateFilterNote Input instream
DeflateFilterNote Output outstream
DeflateFilterNote Ratio ratio


The following line defines a new logging format to be used for the compression log. The format is named "deflate." The second line below specifies the path and file name of the log file (deflate.log) where the output is written.


LogFormat '"%r" %{outstream}n/%{instream}n (%{ratio}n%%)' deflate
CustomLog Z:\IBM\HTTPServer\logs\deflate.log





D.2.2 Example: Configuring mod_deflate for EnterpriseOne

The following load module line enables compression for EnterpriseOne. Verify that the line is uncommented in the httpd.conf file.


LoadModule deflate_module modules/mod_deflate.so


In the httpd.conf file, add the following lines under the existing <IfModule mod_deflate.c> section. Note that the compression method used in this example is explicit exclusion.

For specific instructions to configure the mod_deflate directive, access the Apache documentation on this web page, http://httpd.apache.org/docs/2.0/, and click on the link for http://httpd.apache.org/docs/2.0/mod/directives.html.


<IfModule mod_deflate.c>
DeflateFilterNote Input instream
DeflateFilterNote Output outstream
DeflateFilterNote Ratio ratio
LogFormat '"%r" %{outstream}n/%{instream}n (%{ratio}n%%)' deflate
CustomLog Z:\IBM\HTTPServer\logs\deflate.log
<Location / >
# Insert filter
SetOutputFilter DEFLATE
# Don't compress images or binaries
SetEnvIfNoCase Request_URI \
\.(?:gif|[jm]pe?g|png|t?gz|bz2*|zip|exe|iso|avi)$ no-gzip dont-vary
</Location>
</IfModule>










E Understanding Media Objects on the Web Server

This section provides an overview of jas.ini settings required to access Media Objects on the HTML Server, and the process by which the web server accesses these objects from the network. The last section describes how to secure Media Objects on web-based client machines.

This appendix contains the following topics:

	
Section E.1, "Required jas.ini Settings"


	
Section E.2, "How Media Objects are Displayed by the HTML Server"






E.1 Required jas.ini Settings

Ensure that these parameters are set in the [OWWEB] section of the jas.ini file.


[OWWEB]


	Parameter	Recommended Setting	Description
	MO QUEUE=	Site-dependent path	Identifies the media object directory location on your HTML Server. This path must translate into virtual path /jde/moqueue/ for the web browser.
	FtpPort=	21	Specifies the default port to be used for FTP.
	FtpUsr=	anonymous	Specifies the user id to be used for FTP access to the media Object File Server.
	
	UseMOWinNTShare=	TRUE	Specifies that the web server use the Microsoft Windows file sharing mechanism for fetching Media Object files from their location into the cached location of the web server.
Note: If this setting is TRUE, media object queue paths set in P98MOQUE must be accessible by the owner of the application server from the application server machine (the application server is the server program hosting web servlets). To test the accessibility of a media object queue path, log in as the owner of the application server, open Windows Explorer, and paste the path to the media object queue into the address field. The path should be accessible without entering a user ID and password.

If this path is not accessible, you can change the media object queue setting to a path accessible by the owner of the application server. For example, you can specify a path on the application server machine as the media object queues directory.












E.2 How Media Objects are Displayed by the HTML Server

This section explains how Media Objects are sent to the HTML client by the HTML Server.

	
A user selects attachments on an application which has support for media objects.


	
The Media Object window displays the image, file, or OLE objects, and the user selects one of these objects.

[image: This image is described in surrounding text.]

	
The request goes to the web server.


	
The web server reads the location of the object from the Media Object queue table (F98MOQUE), finds the file, and caches it in the location specified by the MO QUEUE path.

If UseMOWinNTShare is TRUE, files are transferred using Microsoft Windows file sharing mechanism, otherwise files are transferred using FTP protocol.




This diagram illustrates the process:

[image: This image is described in surrounding text.]
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USDK18221: New profile creation will now use SDK name 1.7.64.

:N\IBM\WebSphere\AppServersprof iles\AppSrvBi\bin>managesdk.bat —setNewProfileDefault —sdkname 1.7_64
USDK1@B11: Successfully performed the requested managesdk task.
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»ADMU31 001 Reading configuration for server: servert

»ADMU32001 Server launched. Waiting fa iniialzation status.

>ADMU300DI: Server server! open for e-business; process idis 1164

Server port number is:9080

IVTLOD101: Connecting to the denicint2.miab jdedwards com WebSphere Application Server on port 9080

IVTLOD151: WebSphere Application Server denicint2.miab jdedwards com s running on port: 8080 for profile AppSIVO1

Testing server using the following URL http:idenicint2 miab jdedwards com:3080/iiiserverparm2=hiserviet

IVTLODS0: Serviet engine verification status: Passed

Testing server using the following URL http:idsnicini2 miab jdedwards com9080jivivtserverpanm2=iviAddition jsp

IVTLODSSI: JavaServer Pages files verification status: Passed

Testing server using the fallowing URL:hito:denicint2.miab jdedwards.com 9080/iviserver?parm2=iel

IVTLODGOI: Enterpriss bean verification status: Passed

IVTLO0351: The Installation Verification Tool is scanning the ZAIBMishSpherslAppServeriprofilesiAppSi1iogsisenvert SystemOutlog fils for errors and warn|
[1/30/09 4:55:20:346 MST] 00000000 WSKeyStore W CWPKIDDA1W: One or mare key stores are using the default password,

[11/30/09 4:55:27:502 MST] 00000000 ThreadPoolMgr i WSYROB26W: The ThreadPool ssting onthe ObjectRequestBroker senvice is deprecated
IVTLODADI: 2 errorsiwarmings are detested in the Z\IBMiWebSpherelAppSemveriprofilesiAppSnD liogsiserver! SystemOutIog file

IVTLOO701: The Installation Veriication Tool verification succeeded.

IVTLO0SOI: The installation verification is complete
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IoH Websphere Appiication Server Network Deployment s 3 productionsready Java Platform, Enterprise Edtion (Java EE) compiant application server for the deployment of enterpriss web
services solutons for dynamic e-business. It s the next levelin appltcation serving beyond the WebSphere Appication Server base edtion because i provides advanced web services and
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and weh server definiion are used when creating the default plug-in
configuration file. This file s used {o route requests to the Application Server. If
there are multiple Application Servers, then select ane of the Servers and speciy
the machine's host name.

[ Installthe [BM HTTP Semver Plug-in for [EM WebSphere Application Server
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“This wizard installs or uninstalls maintenance packages, including interim
fixes, ix packs, and refresh packs. The following products are supportect

‘@ IBM WehSphere Application Server Version 6.1.0.0 or higher

‘@ IBM WebSphere Application Server Network Deplogment Version
6.1.0.00r higher

@ IBM WenSphere Application Server - Express Version 6.1.0.0 or
higher’

‘@ IBM Application Client for WebSphere Application Sever ersion
6.1.0.00r higher

‘@ Weh Server Pluc-ins for WehSphers Application Server Version
6.0.0.00r higher.

‘@ IBM WebSphere Application Server V6.1 Feature Pack forWeh
Senices

@ IBM WehSphere Application SetverV6.1 Feature Pack for EJB 3.0

‘® IBMWebSphere exirerne Scale Version 7.0 or higher

‘» WebSphere Virlual Enterprise 6.1 or hioher

‘@ IBMHTTP Server Version 6 or hioher
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“This form allows the creation of a Manifest objsct in  Serialized Object Table
using a Spec Manifest derived rom an XML Spec Package. You can create a
manifest fom the currently connected package only.

Manifest info

Package Name : STAGNGFC
Fackags Build Date : Wed Dec 28 14:51:56 MST 2005

Packags Deploy Date - Wed Dec 28 14:51°56 ST 2005

Date packags was detected by 5.0, Syster : Mon Jan 30 14:34:54 MST 2006

Update Packages
Narme Build Date Deploy Date Detect Date.

Manifest Auit info

Audit user= NL5732403, host = den-nas732403c, port
6081, Timestamp = ban Jan 30 14:34:52 MST 2006

Create Manifest cancel
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Passwar

Chaose whether to use a Windaws service to rur IBM HTTP Server and 1M
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| <Bak | nea»

|| cance |






OEBPS/img/update_http_2.gif
Updates

Features T nstal

=) T HTTP Serve for Websphere Applcation Server 85.5.0
([ 5.5.5.0-WS-WASIHS-HuiOS-FPYB7505 5.5.5000.20130725 1113
£ TEMHTTP Serve or iebshere Appcation Server 6.5.5.0






OEBPS/img/confwebserscriptpt1win70.gif
Z:NIBMNHITPServer\Pluginssbindconf igurevebserver8l.bat
1iAS¥73571 By request. this scripting client is not connected to any server proc
o533 Cortain conf iguricion and application operations will he available'in local
WASK73631: The following options are passed to the scripting environment and arel
available as argunents that are stored in the argy variable: “LuchserverSi, IHS|

S\\IBH\NHTTPServer, Z:\\IBHNNHTTPServerN\conf\\httpd.conf, 81, MAP_ALL. Z:\\
nnxxgiiyﬁﬁrugr\\ylugxns, managed, denicint2Node02, denicint2.mlab.jdeduards.com,

Tnput pavameters:

Ueh server name
lieh server tupe

Uleh server install location
Uleb server config location

vehserverst
THS

Z:NIBHNHTTPServer
Z:NIBMHTTPServersconf\httpd.conf

Ueh sexver port 81
Map fipplications MAP_ALL

Plugin install location Z:NTBH\HTTPServer\Plugins
Uleh server node type managed

Weh server node name denicint2Nodedz

THS Adnin port 08

IHS Adnin user ID
IHS Adnin password
IHS service name

Creating the web server definition for webserverSi.
Paraneters for administering IHS weh server can also be updated using wsadnin scl
ript or admin console.

Step ServerConfigStep successful for Web server definition webserverSl

Step RemoteServerConfigStep successful for Ueb server definition webserverSi

lieh server definition for wehserverSl is created.

Start computing the plugin properties ID.
Plugin properties ID is computed.

Start updating the plugin install location.
Plugin install location is updated.

Start updating the plugin log file location.
Plugin log File location is updated.

Start updating the RemoteConfigFilename location.
Plugin remote confiy file location is updated.

Start updating the RemoteKeyRingFileName location.
Plugin remote keyring file location is updated.

Start saving the configuration.
Configuration save is conplete.

Computed the list of installed applications.
Processing the application Defaulthpplication.

Get the curwent target mapping for the application DefaultApplication.

Conmputed the current target mapping for the application DefaultApplication.
Start updating the target mappings for the application Defaultfpplication.
Target mapping is updated for the application DefaultApplication.

Processing the application ivtApp.
Get the current target mapping for the application ivtApp.
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Installation Directory

1BM Updiate Installer for Websphere Software, Version 7.0.0.0 will be installed ta
the specified directory.

ou can specify a different directory or click Browse to select  directory.

Directory path

owse.

IV Create a start menu icon
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5724 HES, 3635-N02, 5733-W70

(C) Copyright Internationsl Business v






OEBPS/img/jdbj_spec_datasource.gif





OEBPS/img/generate_reports.gif
€ Generator v5.2

BEX]

X

Fie_Generste Logs Options_Help

Generate Reports

Generate Reports By

(© Report Name: | Ro008P Repart Versian:

O System Code:

XJDEDDD!






OEBPS/img/toolbox_config_add_loca.gif
Add Web Server Plug-in Location

‘dd a previously nstalled Web server plug-in ocation to your working set,

Weh server plug-i location

Name:

Location:

TH5_webserver]

Z:\1BMiwebSpheretPlugins|

==






OEBPS/img/success_relaunch_win70.gif
Installation Complete

Success:The following maintenance packages were installed,
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WS WASSDK WInX32-FP0000029

to the following location:

® ZBM\WWebSphere\AppServer
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to exitthe wizard,
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1BM HTTP Server communicates using the port numbers listed below. ffthese
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the port numbers from their defaultvalues
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HTTP Administration Port
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fixes, ix packs, and refresh packs. The following products are supportect

‘@ IBM WehSphere Application Server Version 6.1.0.0 or higher

‘@ IBM WebSphere Application Server Network Deplogment Version
6.1.0.00r higher

@ IBM WenSphere Application Server - Express Version 6.1.0.0 or
higher’

‘@ IBM Application Client for WebSphere Application Sever ersion
6.1.0.00r higher

‘@ Weh Server Pluc-ins for WehSphers Application Server Version
6.0.0.00r higher.

‘@ IBM WebSphere Application Server V6.1 Feature Pack forWeh
Senices

@ IBM WehSphere Application SetverV6.1 Feature Pack for EJB 3.0

‘® IBMWebSphere exirerne Scale Version 7.0 or higher

‘» WebSphere Virlual Enterprise 6.1 or hioher

‘@ IBMHTTP Server Version 6 or hioher
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& 18M Installation Manager [ [0[x]

Install Packages f

The follwing package was staled:

=1 ¥, Web Server Plug-ins for I8M WebSphers Application Server 6.5
0 Web Server Plugrins or I6M Websphere Appication Server 5.5.0.0

Note: I the packagss support rollack, the temporary directory contains rolback fies for nstalled
packages. You can delets the fles on the Fles for rolback preference page.

@ Fiish
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@ Profile Management Tool 8.5

Environment Selection

Select a specic type of environment to reate.
Envronments:

5/ WebSphere Applcaton Server
el (deployment manager and a federated applicaton server)
Management

Custom profie
Secure proxy (configueaton-oriy)
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SR i, Ak

T hpplication server environment to create: Application server
Location: :\IBM\Uebsphere\AppServer\proi les\ kppsrv0l
Disk space required: 200 1B

2 profile nae: AppSrvol
Mk this profile the decault: True

© Wode nane: denicincaNode0l
Host nene: denicinca.nleb. Jdedvards.con

o Enable sministrstive securicy (secoumended]: False

 Adminiscrative console port: 3050
Adninistrative console secure porc: 9043

HIT? cransport ports 9000

KTTFS transport pore: 5443

Bootacrap port: 2809

14 50RP comnector porc: ssed]

15 Run spplication server as a service: True
I6 Creace a Ueb server definicion: False
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) 18M Installation Manager
Fle Help

[_[CIx]

IBM Installation Manager

Install

Instal software packages

Update

Discaver and nstal updiates and
fixes to nstalied software packages.

Modify

Change installed software packages
by adding o removing Features and
functions.

& b Roll Back
ﬂ Uninstall
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Features

1) Web Server Plug-ins for 16M Websphers Applcation Server 8.5.5.0
169 Websphere SDK for Javs Technelogy Edin &
O 1632 bt WebSphere Rurkine Enviorment for Java

160 64t Websihere Runtime Enironme or Java
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Il

Flease read the following license agreement careflly.

intemational Program License Agreement
Part 1 - General Terms.

BY DOWNLOADING, INSTALLING, COPYING, ACCESSING, OR USING THE
PROGRAN YOU AGREE TO THE TERMS OF THIS AGREEMENT. IF YOU ARE
(CCEPTING THESE TERMS ON BEHALF OF ANOTHER PERSON OR A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT AND WARRANT THAT
‘OU HAVE FULL AUTHORITY TO BIND THAT PERSON, COMPANY, OR LEGAL
ENTITY TO THESE TERMS. IF YOU DO NOT AGREE TO THESE TERMS,

[rossmarmuems |

I accept both the [BM and the non-lBM terms

) 1do not acceptthe terms in the license agreement

[ e |

< Back Next> || cancel
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Althe following updates were nstalec:

Installaton Director

Update.

=) ¥, 18M WebSphere Application Server ¥8.5
= [ 18M WebSphere Application Server Network Deployment 8.5.5.0
[ 5.5.5.0-WS-WAS-IFPMBS206 6.5.5000, 20130525 1045
[ 5.5.5.0-WS-WAS-IFPMBS365 6.5.5000, 20130525 1108
[ 5.5.5.0-WS-WAS-IFPMS0S38 6.5.5000, 201306070647
[ 5.5.5.0-WS-WAS-IFPMS3496 6.5.5000, 20130723 1455
([} 6.5.5.0-WS-WASND-AIOSEceptBH-IFPH79754 6.5,5000.20130711_1041
[ 5.5.5.0-WS-WASND-AIOSE ceptBHI-IFPHO0GB1 6.5.5000,20130613_0855
X 18M WebSphere SDK Java Technolagy Edton (Optional) 7.0.4.1
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< \IBM\WebS phere\AppServer\prof iles\AppSruBi\bindmanagesdk.bat —enableProfileAll ~sdkname 1.7_64 —enableServers
USDK1B171: Profile AppSruBi now enabled to use SDK 1.7 64.
WSDKIBB1: Successfully performed the requested managesdk task.
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Welcome to the IBM Update Installer for WebSphere Software wizard

“This wizard installs or uninstalls maintenance packages, including interim
fixes, ix packs, and refresh packs. The following products are supportect

‘@ IBM WehSphere Application Server Version 6.1.0.0 or higher

‘@ IBM WebSphere Application Server Network Deplogment Version
6.1.0.00r higher

@ IBM WenSphere Application Server - Express Version 6.1.0.0 or
higher’

‘@ IBM Application Client for WebSphere Application Sever ersion
6.1.0.00r higher

‘@ Weh Server Pluc-ins for WehSphers Application Server Version
6.0.0.00r higher.

‘@ IBM WebSphere Application Server V6.1 Feature Pack forWeh
Senices

@ IBM WehSphere Application SetverV6.1 Feature Pack for EJB 3.0

‘® IBMWebSphere exirerne Scale Version 7.0 or higher

‘» WebSphere Virlual Enterprise 6.1 or hioher

‘@ IBMHTTP Server Version 6 or hioher
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‘Available Maintenance Package to Install

Select maintenance packages to install

Select Recommended Updates Clear All Selections

¥ 7.0.0-WS-HS-WinX32-FPO000028 pak |
IV 7.0.0-WS-WASSDK-WInX32-FPOD00023 pak

I 7.0.0-40/6-PLG-Ain32-FPO000028 pak - This product s not applicable
= 7.00-AB1/AB-ANina2-FPOD00028 k- This produst is ot applicaile

Eath package selection might restrict remaining packages available for further |
selection,

Multiple selections can be made for diferent products

ClickNext to continue
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Updating.: Retrieving fls at 682 KBfs. 672 MB of 825 MB (827%) completed,
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4 Profile Management Tool 8.5 [-[OIx]

Profile Creation Summary

Review the information n the summary for correctness, If the nformation s correct, click Create to start creating a new profile. Cick Back to changs vales on the
previous panels.

‘Applcatian server enviranment to create: Applcation server
Location: Z{{1BM\WebSpherelAppServer|profiesiappSrvol
Disk space required: 200 ME

Profile name: AppS Vo1
Make this profe the defaul: True
Performance tuning setting: Standard

Node name: DENPT#220iace01
Server name: serverl
Host name: DENFTW22,mlab,jdedwards.com

Deploy the adminitrative console (recommended): True.
Deploy the default applcation: True

Enable acniistrative securty (recommended): False:

Adrinistrative console port: 9060
Adrinstrative console secure port: 9043
HTTP transport port: 9080

HITPS transport port; 9443

Bootstrap port: 2609

50AP connector port: 5830

Run apolication server as a service: True.

<o P e
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Instalation Packages Status Vendor Ligense Key Type.
=010 Applcation Client for 16V WebSphere Application Server

DI version 85.0.0 =
= C1 1) 18M HTTP Server for WebSphere Applcation Server Installed

O, version 8.5.0.0 Installed =
£ 001 18M webSphere Application Server Network Deployment Installed

O, version 85.0.0 Installed =
010 Pluggable Application Client for 18V Wiebsphere Appiication Server

O, version 85.0.0 =
=01 ) Web Server Plug-ins for I6M WebSphers Application Server Installed

DI, version 85.0.0 Installed =

o Verson 8.5.0.0 Wilbe nstalled M

= C1(E 18M websphere SDK Java Technolagy Editon (Optional) Installed

O version 7.0.1.0 Installed 1M
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Integrated Solutions Console Welcome Help | Logour

SOl Closs page

View: [All tasks

Guided Activities

E Massages

e g
[ PLGCO0621: The plug-in configuration file is propagated from Z:\1BM\WebSphere
£ Senime fyyan \AppServer\profiles\AppSrv01\config\celis\denicint2Node01Cell\nodes <
Wi e e \oniaNaa0 1 rvere absan s P g ta 2 \IBMATTPSarver
VR e s b e e
Wi [0l PLGCO0481: The propagation of the plug-in configuration file is complete for the
Web server. denicint2Node01Cell.denicint2Node01.webserver80. k-
e
ervices ‘Web servers E.
e Use this page to view a list o the installed Web servers. 3
= Bt
= o] 5 e [ Dot T Tamstem ] ]

ystem administration

Users and Groups

[seiea[Nare 5 [Web samvrype 0 [ et S e [Varsion 5[ satus &

Monitaring and Tuning

You can administer the folloving resources:

roubleshooting

[) | mbssna ow HTTP Sever | ceniinatodeds | deniinz miah dedvards.com [ 10700

Service incegration
Total 1
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€ Generator v5.2

BEX]

X

Fie_Generste Logs Options_Help

Generate Business Views

Generate Business Views

Business View Name:
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Installation Summary

Review the summary for correctness. Click Back ta change values on previous
panels. ClickNext to begin the installation

The following product will be installed:

@ IBM WebSphere Application Server Network Deployment
Product installation focation: Z\BMiNehSphere\AppServer

The following features will be installect
@ Cors productiles
Total size:

» 1196 1B

Application server emvironment

= o
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) 18M Installation Manager [_[CIx]

A niew version of I6M Installation Manager i avaisble. IF you do not update
the Installation Manager you ill ot be allowed to nstal some packages that
reauite the new version of the Instaliaton Manager.

0 you want to update the Instalation Manager?

Vs o Detalls >>
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€ Generator v5.2

Fie_Generste Logs Options_Help

Generate NERs

Generate NERs.

NER Nrre:
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The following plugein configuration file (lugin-cfasxm) will be created and used for
configuring the selected Web server. This default lacation can be thanged to specity
another existing plug-in configuration fie.

MLl =otvare | | o comer plugin-ctgseni e

[ZUBMHTTPServerPluginsiconfigwebserveraDiplugin-cigxmi

Browse

it Bfeld

<Back cancel
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[-[CIx]

Selectthe Web server configuration files and identfy the Web server portta canfigure
the Weh server definiion.

Salectthe existing IBM HTTP Server htfpd. conf il

Browse.

Specify the Web server port:

o

il el

=<Back HNext> Cancel
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WebSphere Application Server Environments

Selectthe type of WebSphere Application Server emvironmentto ereate during
installation. Although arily ane enviranment tye can be chosen, addiional
profles can be created after installation using the Profile Management Tool
Environments

Cell (deployment manager and a managed node)

Management

Custom
Secure proxy (configuration-onh)
Nane

Description

A stand-alane application server enviranment runs your enterprise
anplications. The application server is managed fram its own administrative
console and functions independent of al other application server and
deployment managers

<Back Hext> Cancel
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:NIBMNUs bSphere \ppSeruerprof iles\AppSruBL\binnanagesdk.hat -listAuailable
USDKLBA3L: Availahle SDEs :

USDKLBASL : SDK nane: 1.6_64

USDKLBAS L : SDK nane: 1.7 64

USDKLBALL: Successfully perfarmed the reguested managesdk task.
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onputed the current target mapping for the application ivtApp.
Start updating the target mappings for the application ivtApp.
Target mapping is updated For the application ivtApp.

Processing the application query. .

Get the current target mapping For the application query.
Conputed the current target mapping for the application query.
Start updating the target mappings for the application query.
Target mapping is updated For the application query.

tart saving the configuration.

onfiguration save is complete.

\IBM\HITPServer\Plugins\bin®,
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Update global Web server plu
configuration

WebSphere variables
Shared libraries
SIP application routers
Replication domains
URI Groups

Naming

05Gi bundle repositories

Update global Web server plug-in configuration

Use this page to create or update 3 global plug-in configuration file for 2
call. The seftings in this configuration file are based on the topology of the.
call. Tha web sarver plug-in configuration file controls whather an
Spplcation sarver o the web sarver handles usar requests. You must
regenarats this global plug-in configuration fils whanever you change the
configuration seftings for an application server, clustar, web containar
transport, or virtual host alias that is contained in the call. You must also
reganerats this file whenaver you add 3 new application server, cluster,
web container transport, or virtual host slias to the call. The global plugin-
chg.xml file is placed in tha Sevas_profile_homeSk/config/calls diractory.
This configuration fils includes tha URI for l of the applications that are
deployed in this cell. If your web server is locatad on 3 remote machine,
you must manually move this plug-in configuration file to that machine.

Click OK to update, or dick Overvrits to gansrate a new plug-in
configuration file.

(o] [_overwrte | [ cancel

View or dounload the current Web server olugin confiquration file
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@ Password Req

Password Required

Credentials are required to connect to the IoM download st Enter
IBH ID and password

User name;

password:
T~ Save password

Saved passords e stored on your computer n afile which i dificut, but not
impossile, for an intruder to read.

Eoiet Vol B0  Foraot vour passworde  [BM1D help and FAQ
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Maintenance Operation Selection

& Install maintenance package.

€ Uninstall maintenance package.






OEBPS/img/generate_ds.gif
€ Generator v5.2

BEX]

X

Fie_Generste Logs Options_Help

Generate Data Structure

Generate Data Structure

Deta Structure Name:
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& 1BM HTTP Server

[Tl

HTTP Administration Server Authentication

Create  userID and password to authenicate to the [BM HTTP Server
administration server using the WebSphere Application Server administrative
console. The newly-created user ID and password is encrypted and stored in the
conffadmin passwa file. You can create additional user [Ds after the installation
by using the hipasswd utiity.

Cres auser D o [BM HTTP Bsner adinstatn save shentcaon,
o
Intpamin ]

Password

Canfirm Passwar,

Il

<Back Next> Cancel
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installation Summary’

The following maintenance packages will be installect

‘® 7.0.0-WS-WAS-WinX32.FP0000029 - WehSphere Application Server
7.0.0.29 FirPack
‘® 7.0.0-WS-WASSDK-WinX32-FP0000029 - Software Developer Kit 7.0.0.26

to the following location:

® ZBMWebSpherelAppServer

ClickNext to begin the installation.
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Installation directory

el server plug-ins for [BM WebSphere Application Server, Version 7.0 will be.
installed to the specified directory.

Speciy a diffsrent directory or click Browse to selecta different install location.

Produst installation location

wse,

Il

< Back Next> Cancel
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Install Packages

A package group s 3 location that contains one or more packagss. Some compatible packages can be installed nto  common package aroup and wil share a common user interface. ;

Select an existing package group, or reate a new one.

Il Ueenses [ losion ) Festures

O Use the existing package group
@ Create a new package group

Summary.

Package Group Name Instaleton Directr Archtectine
%, WebSphere Customization Tookox V8.5 Zi\BMywebSphere| Toobox

Package Group Name: WebSphere Customization Toobos 8.5

Installstion Directory: [ Zi\IBMiWebSphere|Toobox Browse,

Details
Shared Resources Directory: Z:\WebSpheressiIMshared

Disk Space Information

Volume  Avalable Space
z 00868
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Install Packages “‘Q

Review the summery informetion.

Tl Ueenses 0 Locaton ) Festwes [ Summan )

Target Location

Package Graup Name: Websphere Customization Toobox V8.5
Installaton Directary: ZlBMwebSphere{Toobox
Shared Resources Directory:  Z:\WebSpherediIMshared
Packages
Packages

=1 WebSphers Customization Tookox 8.5.0.0
[ Web Server Plug-ins Configuration Tool

Environment Disk Space Information
Englsh Total Avaiable space
z 0868

Total Download Size:  48.02 M
TotalInstalation Sze: 306,36 MB

» Repository Information

Instaling.: Retrieving fls at 164.1 MB/s. 12 M8 of 48 M (26%) completed,

I ——— Pause Downoad | Cancel
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Maintenance Package Directory Selection

Enter directoryto list maintenance packages available for installation. You can |
specify a directory or clickBrowse 1o select a path to maintenance package.

Direstn
[Z1BiWeGSahere Updatensiaermainienance |

Browse |

The latest maintenance packages are available online. Obtain maintenance
packages forWebSphers Application Server and allWebSphere Application
Server Feature Packs either byvisiting the Recornmended fives for WebSphere
Application Server webpags for a complete list or by using the WebSphere |
Maintenance Download wizard to find specific maintenance packages.

Addiional information can be found online atthe WebSphers Application Server |
library or WehSphers Application Server information center wehpages. |
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BM\HTTPServer

eysiserverke:

cdb] [-[ofx]

st e s et =]
D dER
e e T
Key Label
e
Version
File Name: ZUBMHTTPServenkeys!
Token Label: Key Size 1024 | v
Signature Algorithm SHATWIthRSA | v
Ereee CommonName  (optiona [denicini2 miab dedwards com = Recoive.
e | T e e I Detete
Organizational Unit {optional) |JDEdwards —
Locality {optional) |DENVER View/Edit...
State/Province {optional) |COLORADO
fooLomapo | Exportimport,
Zipcode {optional)
Country or region  (optional) [US | v Recreats Beguest.:
Valttyperiod For | ooy e
By e
Email Address  (optional)
1P Address {optional)
DNS Name {optional)
[ Now Sei Sined.
oK Reset Cancel Extract Certificate...

[The requested action has successfully completedt
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Il

Enable Administrative Security
Choose whether to enable administraiive security. To enable securiy, specifya
user name and password to log in o the administrative tools. The adrministrative
user s created in a repository within the Application Server. After installation
finishes, you can add more users, groups, or extemal repositories.

I~ Enabis admiisiative seury

User rare.

o

o passn

See the Information Center for more information about adminisirative securty.

<Back HNext> Cancel
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€ Generator v5.2

=

FleGererste Logs Options_Help

Specity Settings
Connestion
O Direct Generstion
() Erter JAS ServerName | WEBSERVER 1
Spec Files
O Defeut Spec Fies
O Certral Obects FathCode
@ Package. FB12A Package
Central Ofjects - PDB12 Datasource

Bulk Generation File

Bk Generation Fil:

9 | He

» | connect
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& 1BM HTTP Server

Success: The following product was successfully installed:

‘® IBM HTTP Server - ZUBMHTTPServer

For information on configuring and using the IBM HTTP Server, refer to the an-line.
IBMHTTP Server Information Center,

Click Finish to exi

Bl

B y Einish






OEBPS/img/profile_man_tool_typical.gif
4 Profile Manag

nt Tool 8.5 (=] B3

=4

Choose the profilscreation process that meeks your needs. Pick the Typical option to alow the Profil Menagemen Tool o assign a set of defauk configuration values to
the profie. Pck the Advanced opton to specfy your on configuration values for the profe.

Profile Creation Options

 Typical profe crestion

Create an application server profiethat uses defauk configuration settings. The Profle Hanagement Toolassigns unique names tothe proflle, node, and host,
‘The toolaso assigns unique port values, The adiministrative console and the dafat appicaton wilbe nstalied. You can optionaly select whether to enble
‘adniistrative securky. The tool ight create a system servic to rn the appication server depending on the operating system of your machine and the
privieges sssigned to your user account.

Note: Defauk personal certficates expre n one year. Select Advanced profle creaton to reate  personal certicate with a diferent expiration.

€ advanced profie creation

(Create applcation server using default configuration settings or speciy your ow vakues o settngs such as the ocation o the profe and names of the profile,
node, and host. You can assign your own port values. You can optionaly choose whether to deploy the adrinistrative consale and Samgle appication, and

create a Web server defingion. You might have the option o un the applicaton server as a system service depending on the operating system of your machine
‘and the privieges assigned to your user account;
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& preferences [ [olx]
[ — Repositories

Repositories
Appearance Repositries

Fils or Rlback Location Comnection g
2i\Software|WASSSIND\repository config

Help

Py
Internet Zi{SoftwarelWASe5|5upplirepository. config Y Edit Repository.
Passport Advantage 2| Software|WASBS|1DK17)repostory.config % emove Reposton
Updates emove Repository
ove Lp
iaye Do

Clear Credential

Test Connections

Servics repasitaries are remate locations where pdates or extensions to packages (incuding the Installation Manager itsel) are
stored,

IV Search service repostaries during instaltion and updites.

Resors oo | sy
® ==
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el

Installation Complete

Success:The following maintenance packages were installed.

® 7.0.0-WS-WASSDK-WinX32-FP0000029
® 7.0.0-WS-HS-WinX32-FP0000029

to the following location:

® ZUBMHTTPServer

ClickRetaunch ta add or remave additional maintenance packages, or click Finish
to exitthe wizard,

- o
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& 1BM HTTP Server

Installation summary

Reviewthe summary for correctness. Click Back o change values on previous
panels. ClickNext to begin the installation.

1BM HTTP Server will e installed to the fallowing location:
ZUBMHTTPServer
with the following configuration:
HTTP Port: 80
HTTP Administration Port: 8005
HTTP Service Name: [BM HTTP Server 7.0
Administration Service Name: [EM HTTP Administration 7.0
User ID for HTTP Administration Server Authentication: fitpadrin

Total size:

196 MB

| <gack [ [new> | || cancel






OEBPS/img/profile_man_tool_security.gif
& Profile Management Tool 8. [-[o]x]
Administrative Security

Q

o

‘Choose whether to enable adnintrative securkty. To enable securky, supply a user name and password fo logging into sdministrative tooks. This administraive user s
created n a reposkory within the appcation server. Aftr profile creation Fishes, you can add more users, groups, or extenal repostaries.

I~ Enable administrative securky.

User neme:

PaszAord]

‘See the iformation center for more iformation about administrative securty.
View the oniine information center
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USDK18221: New profile creation will now use SDK name 1.7.64.

:N\IBM\WebSphere\AppServersprof iles\AppSrvBi\bin>managesdk.bat —setNewProfileDefault —sdkname 1.7_64
USDK1@B11: Successfully performed the requested managesdk task.
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& 18M Installation Manager [_[CIx]

Install Packages nﬁfg

Select aocation for Instalaton Manager.

Tnstal Licenses Location ) Summary

 once instaled, 18M Installation Manager il bs used to nstal, update, modfy, manage and uninstal your packages.
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USDK1@O11: Successfully performed the requested managesdk task.
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Welcome to WebSphere Application Server
Network Deployment

1BM WebSphere Application Server Network Deployment, Version 7.0is an
integrated platiorm that contains an Application Server, Web development
tools, a Wb server, and additional supporting software and documentation
This launchpad may serve as a single point of reference for installing your
Application Server environment

We recommend viewing the installation diaqrarns for illustrations of
common application server mvironments. For full documentation visitthe
on-fine WebSphere Information Center.

To begin, select an entry from the list belowta iniialize a product installation
wizard Altematively, select a product on the navigation listto leftto read
descriptions ofthe products, and browse help documentation and support
links before starting an installation wizard

 IBMHTTP Server

&' Launch the installtion wizard for B HTTP Server.
~ Weh Server plug-ins.
N

Launchthe installation wizard for Web Server plugins.

 WehSphere DMZ Secure Proxy Server
&' Launch the instalation wizard for DMZ Secure Prosy Server.

-+ Application Clients
B Launch the instalation wizard for Application Clients.
~ 1BM Update Installer for WebSphere Software

& Launch the instalation wizard for [BM Undate Installr for
WebSphers Sofware
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When you install packages, fls are stored in two locations:

1) The shered esources directory - resources that can be shared by muile packages
/A, 2)The istaltion drectory - any resources that are unique to the package that you are nstaling

Important: You can anly select the shared resorces directory the firt tine you instal a package with the [6M Instaltion Manager. For best resuts select the cive with the most
avalable space because t must have adequate space fo the shared resources of future packages.

Shared Resources Directory: [ Z:VBMIMShared| Browse.

Disk Space Information

Volume  Avalable Space
z 547068
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Success: The following product was successfully installed:
= IBM Update Installer for WebSphere Software
Patt Z\IBUWebSpheralUpdatelnstalier
¥ Launch IBM Updiate Installer for WebSphere Software on exit

You can also launch the Update Installer by running the update command in the
installation directory.

Click Finish to exitthe wizard,

[Efield
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‘The Profile Management Tool created the profile successfully.
The next step isto decide whekher o federate the appication server into a deployment manager cel.

To Federate the applcation server, use efher the addNode conmand or the adninistrative console of the deployment manager. Using the adninsrative console
requres the applcation server to be running

You can start and stop the applcation server from the command Ine o the Firt steps console. The Fist steps console also has inks to n nstalaion verfication test
‘and other nformation and features tha relate to the applicaton server

¥ Launch the Frt steps console.

To star the Profle Management: Toolleter, se the PMT command i the agp_serve. rooflbin|Profietianagement dectory or the option in the Firt steps consale.
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